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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2006 Hewlett-Packard Development Company, L.P.

Trademark Notices

Java™ is a U.S. trademark of Sun Microsystems, Inc.

Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group.

Windows® and Windows NT® are U.S. registered trademarks of Microsoft Corporation. 

All other product names are the property of their respective trademark or service mark holders and are 
hereby acknowledged.
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Documentation Updates

To verify that the manual you are using is the most recent edition available, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

Check the date on your PDF, scan down the list to locate the product, then look to see if a more recent edition 
of your document is available for downloading. If you subscribe to the appropriate product support service, 
you can arrange to have document updates sent to you. Contact your HP sales representative for details.
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Support

Please visit the HP OpenView support web site at:

http://www.hp.com/managementsoftware/support 

This web site provides contact information and details about the products, services, and support that HP 
OpenView offers.

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit enhancement requests online

• Download software patches

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many also require a 
support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to:

http://www.managementsoftware.hp.com/passport-registration.html
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1 Overview
This chapter covers the following topics:

• Service Desk and Process Automation

• Service Desk reporting in context

• Three report packs for Service Desk:

— Help Desk Report Pack

— Change Management Report Pack

— SLM Report Pack

• Data collection or data export? (SD 4.5 and SD 5.0/5.1 differences)

• How to open reports and admin forms

• Ways to customize reports

• Sources for additional information

Service Desk and Process Automation

Service Desk was created so that IT organizations could reduce unwanted errors, operate 
faster and more efficiently, and gradually improve the quality of their services. These goals 
were achieved by automating the internal processes that an IT organization uses to deliver 
services to paying customers. The following internal processes are automated by Service 
Desk: 

• Service call processing

• Incident tracking

• Problem tracking

• Change approval

• Work orders and work flow

• Service design and definition

• Compliance tracking

• End of evaluation period forecasting

Automating internal processes empowers the helpdesk analyst, the system manager, and the 
service manager. The helpdesk analyst has immediate access to the background information 
needed to resolve service calls as quickly as possible. The system manager can track incidents 
and service calls, see the need for a change, and then respond to that need by starting the 
change approval process, creating a work order, and tracking work flow from start to finish. 
The service manager can design a service by specifying the components that support the 
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service, the customers that receive the service, a support level, and compliance criteria. 
Service Desk calculates the current level of compliance, predicts what compliance will be like 
at the end of the current evaluation period, displays availability and compliance calculations 
in forms and views, and draws the service manager’s attention to configuration items that 
have been associated with service calls and incidents.

Service Desk can answer many questions very quickly. What service calls are associated with 
this particular configuration item? What incidents are associated with this particular 
configuration item? What work group is handling this work order? Which tasks within this 
particular work order have not been accomplished yet? Who has and hasn’t responded to my 
change approval request? Although Service Desk can answer a lot of questions quickly, there 
are some questions that Service Desk alone cannot answer. Here is a sampling of those 
unanswered questions:

• How many service calls are we handling? 

• What portion of incoming service calls are we closing on the first call?

• What is our average close time for escalated database problems?

• Are we meeting our deadlines for system upgrades?

• How do we tell upper management what the help center is doing every month?

• Can we measure the progress we are making in improving service to customers?

• What percentage of service calls are really enhancement requests?

• In which future product releases are we planning to address customer complaints?

• Management would like to know how customers were affected by a network outage. Can 
we easily document the impact for management?

If you are intrigued by the notion that a set of interactive reports could answer these 
questions, quickly and easily, then you will want to know more about HP OpenView 
Performance Insight (OVPI) and the reporting solutions created for Service Desk.

Service Desk Reporting in Context

HP OpenView Performance Insight (OVPI) is a performance management and reporting 
application. Long-term data collection, in-depth analysis of trends, and automated web-based 
reporting are this application’s primary strengths. OVPI runs many kinds of reporting 
solutions. We cover these areas:

• Infrastructure Usage

— Interfaces

— Devices

• LAN/WAN Edge

— Frame Relay (SNMP only) 

— ATM (SNMP only)

• WAN Core

— Frame Relay (multiple vendors)

— ATM (multiple vendors)
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• Traffic Profiling

— RMON II

— NetFlow Interface/NetFlow Global View

• IP Telephony

— IP Telephony Call Detail

— Cisco IP Telephony Statistics

• Quality Assurance

— Cisco Ping 

— Service Assurance

— IP Access Rate

• System

— System Resources

• MPLS VPN

— MPLV VPN Report Pack

In addition to the areas listed above, we have solutions aimed internally, at OpenView 
products. The OpenView products include Network Node Manager, Internet Services, OVPA, 
OpenView Operations, Business Process Insight, the application SPIs that run on NNM and 
OVO, and Service Desk. All the reporting solutions, the ones aimed outside of OpenView as 
well as the ones desiged for OpenView, have the following goals in common:

• Identify bottlenecks

• Improve capacity planning

• Produce compelling documentation for management

Three Report Packs for Service Desk

If you have previous experience with OVPI, you know that an individual report belongs to a 
bigger installable package known as a report pack. You also know that you install a report 
pack using Package Manager and that Package Manager is started from the Performance 
Insight Management Console. The May 2006 release of reporting solutions for OVPI includes 
three report packs for Service Desk:

• Help Desk Report Pack 1.1 (30 reports) 

• Change Management Report Pack 1.1 (10 reports) 

• SLM Report Pack 1.0 (11 reports) 

Each report pack corresponds to a Service Desk module. If you have Service Desk 4.5, and you 
are licensed to use the Help Desk and Change Manager modules, then you can install and use 
the Help Desk Report Pack and the Change Management Report Pack. If you have Service 
Desk 5.0 or 5.1, and you are licensed to use the Help Desk, Change Manager, and Service 
Level Manager modules, then you can install and use all three report packs. 

There are no dependencies between the Service Desk report packs. You may install all three 
report packs, any two of them, or just one.
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Help Desk Report Pack

The Help Desk Report Pack contains reports about service calls, incidents, and problems. 

Service Calls

• Average Duration of Service Calls

• Service Calls by Category

• Service Calls by Classification

• Service Calls Closed before Deadline by Category

• Service Calls Closed by Deadline

• Service Calls Closed on First Call

• Service Call Details

• Service Calls by Closure Code

• Incoming Service Calls (History)

• Incoming Service Calls (Recent)

Incidents

• Average Duration of Incidents

• Incidents by Category

• Incidents by Classification

• Incidents Closed Before Deadline by Category

• Incidents Closed by Deadline

• Incidents Closed on First Call

• Incident Details

• Incidents by Closure Code

• Incoming Incidents (History)

• Incoming Incidents (Recent)

Problems

• Average Duration of Problems

• Problems by Category

• Problems by Classification

• Problems Closed before Deadline by Category

• Problems Closed by Deadline

• Problems Closed on First Call

• Problem Details

• Problems by Closure Code

• Incoming Problems (History)

• Incoming Problems (Recent)
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Change Management Report Pack

The Change Management Report Pack contains the following reports:

• Average Duration of Changes

• Changes by Category

• Changes by Classification

• Changes Closed before Deadline by Category

• Changes Closed by Deadline

• Changes Closed on First Call

• Changes Details

• Changes by Closure Code

• Incoming Changes (History)

• Incoming Changes (Recent)

Service Level Management Report Pack

The reports in the SLM Report Pack are role-specific. The roles are:

• Customer Business Manager

• Customer Relationship Manager

• Service Manager

The reports in the SLM Report Pack provide the following statistics:

• SLA and SLO Compliance during SLA evaluation periods

• SLA and SLO compliance at the end of periods

• Service and CI availability over time

• Service and CI Metric values over time

• Objective thresholds in graphs (for metric values and compliance percentage) 

• Service hours and CI planned downtimes as grey areas in graphs

Customer Business Manager Reports

The following reports are for the Customer Business Manager:

• SLA Overview for Customer Business Manager

• SLA Detail for Customer Business Manager

• Service Detail for Customer Business Manager

• SLO Detail for Customer Business Manager
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Customer Relationship Manager Reports

The following reports are for the Customer Relationship Manager:

• SLA Overview for Customer Relationship Manager

• SLA Detail for Customer Relationship Manager

• Service Detail for Customer Relationship Manager

• SLO Detail for Customer Relationship Manager

Service Manager Reports

The following reports are for the Service Manager:

• Service Overview for Service Manager

• Service Detail for Service Manager

• Configuration Item Detail for Service Manager

Data Collection or Data Export?

If you are using Service Desk 4.5, you must install one datapipe for each report pack. The 
datapipe uses a connection with the Service Desk database to collect data about service calls, 
incidents, problems, and changes. If you have Service Desk 5.0 or 5.1, datapipes are not 
needed. Service Desk 5.0 and 5.1 can export data to OVPI. The data export function, which 
you control and monitor from the OpenView Console Reporting Administration workspace 
view, eliminates the need for datapipes.

If you have Service Desk 5.0 or 5.1 and you want to install the SLM Report Pack, you must 
install DimensionManager and DataFeeder on OVPI. These programs are distributed on the 
Service Desk DVD. If you are not installing the SLM Report Pack, there is no need to install 
DimensionManager and DataFeeder on OVPI.

Data will not appear in reports the same day you install the report pack. Data will not appear 
in reports until after the first daily summarization. The first daily summarization will run at 
2:00 a.m. Will the report you see tomorrow, after installing a report pack today, include 
trending data for Service Desk events that took place last year, or last month, or last week? 
The answer is no. OVPI does not gather historic data from Service Desk and generate 
trending analysis based on historic data. OVPI takes new data from Service Desk and 
assembles the historic view gradually, over time. Install a report pack today and tomorrow 
you will see statistics for the events that took place today. You will not see your first weekly 
summary until next week, and you will not see your first monthly summary until the current 
calendar month ends and the next calendar month begins.

How to Open Reports and Forms

Chapter 3, Installation in a Service Desk 5.0/5.1 Setting, mentions two consoles, the 
Management Console and the OpenView Console. The Management Console is the front-end 
GUI interface for OVPI. The OpenView Console is a front-end GUI interface. Only when OVPI 
and Service Desk are installed on the same machine (standard procedure for report pack 
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demonstration purposes) can you access both consoles from the same machine. In a 
production environment, this is not feasible. In a production environment the Management 
Console and the OpenView Console are always on separate machines.

If you are using Service Desk 4.5, you have three ways to open reports:

• OVPI Report Viewer

• OVPI Report Builder

• Web browser 

If you are using Service Desk 5.0 or 5.1, you have four ways to open reports:

• OVPI Report Viewer

• OVPI Report Builder

• Web browser

• OpenView Console

Opening Reports from the OpenView Console

To open a report from the OpenView Console, follow these steps:

1 Open a workspace view. Select one of the following workspaces:

• Change

• Service Call

• Problem

• Incident

• Service

• Service Level Agreement

• Configuration Item

2 The workspace view opens. Select an object in the view, then click Actions. 

3 The Actions drop-down menu includes a list of reports. The object you selected is present in 
each report. 

4 Click the report you want to open.

Opening Reports from Viewer

To open a report using the OVPI Report Viewer application, follow these steps:

1 Go to the machine where the OVPI client applications are installed.

2 On Windows, select Start > Programs > HP OpenView > Performance Insight > Viewer

3 Report Viewer opens. Select File > Open to display a list of reports.
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Opening Reports from Builder

To open a report using the OVPI Report Builder application, follow these steps:

1 Go to the machine where the OVPI client applications are installed.

2 On Windows, select Start > Programs > HP OpenView > Performance Insight > Builder

3 Report Builder opens. Select File > Open.

From Report Builder you have access to parameters, elements, links, and properties. You will 
see the parameters, elements, and links in a component tree. Properties appear in a list below 
the component tree. The contents of the properties list will change depending on where you 
are in the component tree.

Opening Reports from Your Web Browser

Follow these steps to open reports from your web browser:

1 Enter the address of the OVPI Web Access Server in your web browser. 

2 Click Log On.

3 In the Connect To window, type your OVPI username and password and click OK.

4 Click Catalog.

5 Expand the System folder.

6 Expand the report pack.

7 Select a report.

Configuration and Logging Reports

There are multiple administrator reports, one per report pack:

• Help Desk Management Configuration and Logging Report

• Change Management Configuration and Logging Report

• SLM Configuration and Logging Report

Each admin report displays status and error messages generated by OVPI. The Configuration 
and Logging Report will populate with data several hours before the reports themselves 
populate with data. You can open the admin reports from the OpenView Console, from the 
OVPI Report Viewer, and from your web browser. You will find the admin report for each 
report pack inside the Admin folder. 

Opening Forms

Forms allow you to modify defaults. The only way to access forms is through the General 
Tasks section of the Management Console. Follow these steps to locate General Tasks: 

1 If necessary, relocate to the machine that is running the OVPI client applications.

2 On Windows, select Start > Programs > HP OpenView > Performance Insight > Management Console

3 The Management Console opens. The System pane is on the left.

4 Click the Objects icon.
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5 The Object Manager application opens. 

6 Find the General Tasks section, lower right side of screen. The admin forms are listed here. 

7 Click the form to open to open it.

Ways to Customize Reports

You can customize the contents of a report by applying group filters, by apply constraints (also 
known as editing parameters), and by changing how tables and graphs display. While group 
filters are used by service providers to create customer-specific reports, anyone can apply 
constraints to a report and anybody can make use of table and graph view options. For details 
about view options for tables and graphs, see Appendix C, View Options.

Group Filters

If you plan to share reports with your customers, you must follow these steps to configure 
OVPI to produce customer-specific reports:

• Import custom property information (customer names, device locations, or both) using 
Common Property Tables

• Create a group account for all of the users affiliated with a particular customer

• Create a group filter for the group account

For a fuller explanation of group filters, see the Performance Insight Administration Guide. 

Editing Parameters

Editing a parameter applies a constraint. The constraint eliminates data you are not 
interested in seeing. For example, if you edit the Service parameter, data for every service 
except the service you typed in the Service field drops from the report. If you are looking at 
reports in the SLM Report Pack, you may apply the following case-sensitive constraints:

• Service

• Service Manager

• Paying Entity

• SLA

• CI

If you are looking at reports in the Help Desk or Change Management report packs, you may 
apply the following constraints:

• Start date 

• End date

If you are viewing reports on the web, edit parameters by clicking the Edit Parameters icon at the 
bottom right-hand corner of the report. When the Edit Parameters window opens, enter the 
constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values. When the Modify Parameter Values 
window opens, click the Current Value field. Type a new value and click OK.
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Sources for Additional Information

Service Desk is described in the following documents: 

• HP OpenView Service Desk 5.1 Release Notes 

• HP OpenView Service Desk 5.1 Installation Guide 

• HP OpenView Service Desk 5.1 Administrator’s Guide

• HP OpenView Metric Adapter Developer Guide 

• HP OpenView Service Desk Differences Guide (4.5 - 5.0) 

• HP OpenView Service Level Manager Guide 

• HP OpenView Web API Programmers Guide 

The following user guides and release notes are related to the Service Desk reporting solution:

• Service Desk HelpDesk45 Datapipe Release Notes

• Service Desk ChangeManagement45 Datapipe Release Notes

• Service Desk Change Management Report Pack 1.1 Release Notes

• Service Desk HelpDesk Report Pack 1.0 Release Notes

• Service Desk SLM Report Pack 1.0 Release Notes

• OVPI Report Packs, CD-ROM Release Notes, revised September 2006

The following user guides are related to OVPI core:

• Performance Insight Troubleshooting Guide, April 2005

• Performance Insight Guide for Building and Viewing Reports

• Performance Insight Administration Guide

• Performance Insight Installation Guide

To download manuals for any OpenView application, including manuals for OVPI and the 
report packs that run on OVPI, go to this site:

http://www.hp.com/managementsoftware/support

Select Support > Product Manuals to reach the Product Manuals Search page. The user guides for 
Service Desk are listed under Service Desk. The user guides for OVPI are listed under Performance 
Insight, while the user guides for report packs and datapipes are listed under Performance 
Insight Reporting Solutions. Each user guide entry indicates the month and year the document 
was issued. If a manual is revised and reposted, the date will change. Since we post revised 
manuals from time to time, you should check the date on your PDF against the date on the 
web edition, and use the web edition if it is newer.
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2 Installation in a Service Desk 4.5 Setting
This chapter covers the following topics:

• Software prerequisites

• Service Desk datapipes

• Connecting OVPI to the Service Desk database

• Installing views on Service Desk

• Changing the database server name in .pro files

• Installing Service Desk report packs and datapipes

• Verifying that data is being collected

• Incrementing the time period in .rep files (optional)

Guidelines for a Smooth Installation

Most OVPI reporting solutions have two basic ingredients, one report pack and one datapipe. 
There are some reporting solutions that include multiple datapipes. By installing a datapipe, 
you configure OVPI to create tables, collect data, populate tables maintained by the datapipe, 
and also populate base tables created by the report pack. Data collection is either a matter of 
polling individual devices, reading a flat file created by a preprocessor, or reading a file 
created by trend_export. By installing a report pack, you configure OVPI to create tables for 
the report pack and process data in accordance with specific directives. The directives instruct 
OVPI to calculate totals, calculate averages, and aggregate data in one of several possible 
ways, for example, by customer, by location, by day, by week, or by month.

The Service Desk report packs are shipped as compressed files on a CD-ROM. The CD-ROM 
contains many report packs, many datapipes, and several shared packages. When you insert 
the CD in the CD-ROM drive and launch the package extraction program, the installer 
extracts every package from the CD and copies the results to the Packages directory on your 
system. When the extract finishes, the installer prompts you to launch Performance Insight 
and start Package Manager. Before using Package Manager to install the Service Desk report 
packs, be sure that you meet the software prerequisites, read the short piece below about the 
Service Desk datapipes, and then execute the configuration tasks that begin on page 18.

Software Prerequisites

Be sure the following prerequisites are met before proceeding with installation:

• Your Service Desk server is running Service Desk 4.5 with Service Pack 14

• Your OVPI server is running OVPI 5.1 with Service Pack 3 or later
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• Your RDBMS for OVPI is Oracle 9.2.0.6 

• Your RDBMS for Service Desk is Oracle 9.2.06 or MS SQLServer 2000 SP 3a

If you are not running the latest Service Pack for OVPI, you can download it from this site:

http://support.openview.hp.com/cpe/ovpi/patch_ovpi.jsp

Datapipes for Service Desk Report Packs

Each Service Desk report pack requires a datapipe. The Help Desk Report Pack requires the 
Help Desk Datapipe 1.0 and the Change Management Report Pack requires the Change 
Management Datapipe 1.0.

When you install a Service Desk datapipe, you also install one or more views on the Service 
Desk database. If you install the Change Management Datapipe, you install one view on the 
Service Desk database. If you install the HelpDesk Datapipe, you install multiple views on 
the Service Desk database. 

Both datapipes follow the same steps to populate report pack base tables:

1 Once a day, at 4:00 a.m., the datapipe calls trend_export.

2 Trend_export creates a text file derived from a database view.

3 The datapipe calls ee_collect.

4 ee_collect moves data from the text file to a base table on the report pack side.

For more information about data flow and troubleshooting problems that may arise, see 
Chapter 9, Troubleshooting the SD45 Datapipes.

Configuration Tasks Related to OVPI

The following configuration tasks must be performed before installing either of the Service 
Desk report packs: 

• Task 1: Connect OVPI to the Service Desk database

• Task 2: Perform manual steps related to the installation of views on Service Desk. 

• Task 3: Change the database server name in .pro files

Task 1: Connect OVPI to the Service Desk database 

The Service Desk datapipes cannot collect data from Service Desk until OVPI recognizes the 
Service Desk system as a supported database. Follow these steps to add the Service Desk 
system to OVPI’s list of supported databases: 

1 If you do not know which port the Service Desk database is using, find out. The default 
port for Oracle is port 1521. The default port for MS SQL Server is 1433. If the default 
port is not the port being used, then look for the ORACLE or the MS SQL Server port 
number in the following directory: 

Windows: c:\Windows\system32\driver\etc\services 

Unix: /etc/services 

Service Desk 4.5 datapipes do not work with Sybase.
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2 On the OVPI Server, launch the Management Console by selecting Start > Programs > HP 
OpenView Performance Insight > Management Console. 

3 Click the Systems icon (left side of the Management Console). 

4 Click “+” to expand the information under the OVPI system. 

5 Right-click Databases and select Add Database. The Add Database Wizard opens. 

6 Click Next. 

7 Select Generic Supported Database. 

8 Click Next. The Database Connection Information window opens.

9 Add the following information: 

Hostname – The hostname, or the IP address, of the Service Desk server. 

Port – The TCP/IP port number. 

Description – Use ServiceDesk. Do not use spaces and numbers. You will use the 
description later, during the install sequence. 

Vendor – Select the database vendor for Service Desk. 

Database Instance – Specify the instance for the database. 

Database Username – Username, with sufficient privileges to access the Service Desk 
database and create views of the Service Desk database. 

Password – Database password. 

10 Click Next. The Identify System window opens.
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11 Type a system name. The name should be unique. Do not use spaces or numbers in the 
name. Adding a description is optional. 

12 Click Next. The Summary window opens. 

13 Click Finish. 

14 In the navigational window under System Information, click External Reference Databases. 

15 Select Service Desk and click the Test Connection button. You should receive a Connection 
Successful message. 
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Task 2: Prerequisites steps for automatic installation of views on Service Desk

OVPI collects data from Service Desk by initiating SQL queries against the table structures 
stored in the Service Desk database. The queries sent by OVPI access attributes spread across 
many tables. To make accessing these attributes much easier and faster, four “integration 
views” were created, three for the Help Desk side of Service Desk, and one for the Change 
Management side of Service Desk. The Help Desk views are: 

• ITSM_INCIDENTS_V

• ITSM_PROBLEMS_V

• ITSM_SERVICECALLS_V

The Change Management view is:

• ITSM_CHANGES_V

All four views are installed automatically. Although view installation is automatic, the 
following manual steps must be performed before you install the datapipes:

1 Create a file named Serverfile.txt and copy the file to {DPIPE_HOME}\data. 

2 Add the name of the system (the same name you used when you configured the external 
database connection) and, on the next line, the database-type name to the Serverfile.txt 
file. Put ORACLE or SQLSERVER all in upper case. For example:

SD45_system1
ORACLE

3 If you want to collect data from multiple Service Desk installations, add each additional 
system name and each additional database-type name to the Serverfile.txt file. Do not 
insert any blank lines. For example:

SD45_system1
ORACLE
SD45_system2
SQLSERVER

Task 3: Change the database server name in .pro files

Pass the database server name (the same name you used when connected OVPI to the 
external database) with the –S option of trend_export. Follow these steps:

1 Open this file: 

{DPIPE_HOME}/packages/SD45_DATAPIPE/SrvDsk_ChangeManagement45_DP.ap/
SrvDsk_Chm_Retrieve_Data.pro
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2 Replace each occurrence of the –S database server name with the name you created.

3 Open this file:

{DPIPE_HOME}/packages/SD45_DATAPIPE/SrvDsk_HelpDesk45_DP.ap/
SrvDsk_Hlpd_Retrieve_Data.pro
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4 Replace each occurrence of the –S database server name with the name you created.

5 Optional. If you intend to collect data from more than one Service Desk 4.5 installation, 
perform these additional steps:

a Open this file: SrvDsk_Hlpd_Retrieve_Data.pro

b Replicate the incidents, problems, and service calls sections.

c Replace each occurrence of the -S database server name with the name you created.

d Open this file: SrvDsk_Chm_Retrieve_Data.proReplicate the changes section.

e Replace each occurrence of the -S database server name with the name you created.
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The illustration below shows entries replicated in SrvDsk_Chm_Retrieve_Data.pro.

Installing Report Packs and Datapipes

Follow these steps to install Service Desk report packs and datapipes:

• Task 1: Extract packages

• Task 2: Using Package Manager, install packages

If someone has already extracted packages from the report pack CD, go directly to Task 2.

Task 1: Extract packages from the report packs CD-ROM

1 Log in to the system. On Unix systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services

Unix: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop
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3 Insert the report pack CD in the CD-ROM drive and follow the instructions for extracting 
packages from the CD to the Packages directory on your system. 

Windows: 

• If auto run is disabled, run the setup.bat command; the Main Menu opens.

• If auto run is enabled, the Main Menu opens. 

Unix: 

• Log in as root.

• If the CD does not mount automatically, mount the CD manually.

• Navigate to the top level of the CD directory.

• Run the ./setup command.

• The Main Menu opens.

4 Type 1 in the choice field and press Enter. The install script displays a percentage 
complete bar. When the copy is complete, the install script starts Package Manager. The 
Package Manager welcome window opens.

Task 2: Using Package Manager, install the Service Desk report packs

1 Select Start > HP OpenView Performance Insight > Package Manager. The Package Manager 
welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default destination directory or browse to the correct directory.

4 Click Next. The Report Deployment window opens. Accept the default to deploy reports; 
accept the default for application server name and port; type the username and password 
for the OVPI Application Server. 

5 Click Next. The Package Selection window opens. Click the check boxes for the packages 
you want to install. If you want to install both report packs, click the boxes for:

a SrvDsk_ChangeManagement 

b SrvDsk_ChangeManagement_Demo (optional)

c SrvDsk_ChangeManagement45_DP

d SrvDsk_HelpDesk

e SrvDsk_HelpDesk_Demo (optional)

f SrvDsk_HelpDesk45_DP

6 Click Next. The Type Discovery window opens. Disable the default.

7 Click Next. The Selection Summary window opens.

8 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package installation complete message appears.

9 Click Done.

10 Restart OVPI Timer 

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.
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c From the Action menu, select Start.

On Unix, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Verifying Data Collection

If the datapipes you installed are working properly, the following tables on the report pack 
side will be populated:

• RSERVD_PROBLEMS_DATAPIPE

• RSERVD_INCIDENTS_DATAPIPE

• RSERVD_SERVICECALLS_DATAPIPE

• RSERVD_CHANGES_DATAPIPE 

If these tables were populated with data, you can query OVPI to see how many rows of data 
were collected for each table. Follow these steps:

1 Login to OVPI database using User Id and Password.

2 Run the following queries at the sql prompt:

• select count(*) from RSERVD_INCIDENTS_DATAPIPE;

• select count(*) from RSERVD_PROBLEMS_DATAPIPE;

• select count(*) from RSERVD_SERVICECALLS_DATAPIPE;

• select count(*) from RSERVD_CHANGES_DATAPIPE;

For each query, the system displays the number of rows collected. If the system indicates that 
no data was collected, follow the advice in Chapter 9, Troubleshooting the SD45 Datapipes.

Changing the Time Period in .rep Files

If you want to import more data at a time, more data than the default (3 days) permits, you 
can do that by incrementing the Time Period in the following .rep files:

• ITSM_INCIDENTS.rep

• ITSM_PROBLEMS.rep

• ITSM_SERVICECALLS.rep

• ITSM_CHANGES.rep 

All .rep files are located in the following directory:

{DPIPE_HOME}/lib/
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The time period in a .rep file must not be greater than the retention period of the 
corresponding base table. This rule applies to the base tables listed below. 

If the time period in the .rep file is greater than the retention period of the corresponding base 
table, data mapping errors will result. Follow these steps to increment the Time Period in 
each of the .rep files listed above:

1 Using Report Builder, open the .rep file.

2 Navigate as follows: Elements > ITSM_table name > Data > Query

.rep File Base Table

ITSM_INCIDENTS.rep RSERVD_INCIDENTS

ITSM_PROBLEMS.rep RSERVD_PROBLEMS

ITSM_SERVICECALLS.rep RSERVD_SERVICECALLS

ITSM_CHANGES.rep RSERVD_CHANGES
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3 Click Time Period

4 In the Property-Value table, locate the Length field.

5 Change the value.

The value you enter can be more than 10 only if the retention period for the 
corresponding base table is more than 10.
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3 Installation in a Service Desk 5.0/5.1 Setting
This chapter covers the following topics:

• Software prerequisites

• Installing DimensionManager and DataFeeder on OVPI

• Using Package Manager to install the Service Desk report packs

• Configuring a destination for exported data

• Enabling the Reporting Administration workspace

• Exporting Help Desk module data to OVPI

• Exporting Change Manager module data to OVPI

• Exporting SLM dimension data to OVPI

• Changing defaults related to data aging (SLM Report Pack only)

• Changing defaults related to logging level

Guidelines for a Smooth Installation

Most OVPI reporting solution have at least two basic ingredients, a report pack and a 
datapipe. While the datapipe creates tables, collects data, and populates base tables 
maintained by the report pack, the report pack contains instructions for OVPI that specify 
how to process data, what to calculate, and how to aggregate the results. The reporting 
solutions for Service Desk 5.0 and 5.1 are different. There are no datapipes. Datapipes are not 
needed because Service Desk 5.0 and 5.1 are designed to export data to OVPI.

The Service Desk report packs reside on the report pack CD-ROM. The report pack CD-ROM 
contains many report packs, many datapipes, and several shared packages. Every package is 
compressed. After you insert the CD in the CD-ROM drive and launch the package extraction 
program, a script extracts each package from the CD and copies the results to the Packages 
directory on your system. When the extract finishes, you will be prompted to launch 
Performance Insight and start Package Manager.

Before using Package Manager to install Report Packs, you must verify that the software 
prerequisites are met. Once you have verified that, install DimensionManager and 
DataFeeder on OVPI, install the report packs, and then configure full and incremental data 
exports to OVPI. Once the data exports have run, you can verify that data is reaching OVPI 
by checking the Configuration and Logging Report for each report pack that you installed. If 
data is reaching OVPI, the Configuration and Logging Report will include status messages 
related to hourly processing.
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Software Prerequisites

Be sure the following prerequisites are met before proceeding with installation:

• Your Service Desk Management Server is running Service Desk 5.0 with the latest 
Service Pack, or Service Desk 5.1

• Your RDBMS for Service Desk is Oracle 9.2.0.6 or MS SQLServer 2000 SP 3a

• Your OVPI server is running OVPI 5.1 with Service Pack 3 or later

• Your RDBMS for OVPI is Oracle 9.2.0.6 

If you are not running the latest Service Pack for OVPI, you can download it from this site:

http://support.openview.hp.com/cpe/ovpi/patch_ovpi.jsp

Installing DimensionManager and DataFeeder on OVPI

If you install the SLM Report Pack, then you must install DimensionManager and 
DataFeeder on the OVPI server. DimensionManager receives dimension data (property data) 
from the Service Desk server, while DataFeeder receives fact data from the Service Desk 
server. The export of dimension data is a manual step, which you will take when the SLM 
model is modified. The export of fact data takes place automatically. No user intervention is 
necessary. 

Follow these steps to install DimensionManager and DataFeeder on OVPI:

1 Check that the port defined in the slmreporting.ini file on the Service Desk machine 
matches the port defined in the slmreporting.ini and slmreportingservers.ini 
files on the OVPI server. The port value is usually 1085. If you change this value, you 
must execute the ovconfchg registration tool again.

2 Relocate to your OVPI server and insert the Service Desk installation DVD in a drive on 
the OVPI server; navigate to the reporting directory.

or

From the installation DVD, copy the reporting folder and the packages folder to a 
directory on the OVPI server; navigate to the reporting directory.

3 Do one of the following:

Windows

In the reporting directory, click this file: reporting_5.XX.XXX_setup.exe 

Unix

Type reporting_5.XX.XXX_setup.bin from the command line. 

4 When the HP OpenView installer GUI opens, select Accept License Agreement.

5 Click Next and continue clicking Next until you see a list of java components.

6 Click Install.

DimensionManager and DataFeeder are now installed on OVPI.
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Installing the Service Desk Report Packs

You may install one report pack, two report packs, or all three report packs. There are no 
interdependencies between report packs, that is, no report pack is a prerequisite for the other 
report packs. 

Perform the following tasks to install the Service Desk report packs:

• Task 1: Extract packages from the report pack CD-ROM.

• Task 2: Start Package Manager and install the report packs

If the package extraction step has already taken place, go directly to Task 2.

Task 1: Extract packages from the report pack CD

1 Log in to the system. On Unix systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Stop.

On Unix, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive and follow the instructions in the menu 
for extracting packages from the CD to the Packages directory on your system. 

Windows: 

• If auto run is disabled, run the setup.bat command; the Main Menu opens.

• If auto run is enabled, the Main Menu opens. 

Unix: 

• Log in as root and mount the CD (if the CD does not mount automatically).

• Navigate to the top level of the CD directory.

• Run the ./setup command.

• The Main Menu opens.

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager welcome window opens.

Task 2: Using Package Manager, install the Service Desk report packs

1 Select Start > HP OpenView Performance Insight > Package Manager. 

2 The Package Manager Welcome Window opens. Click Next. 

3 The Package Location window opens. Click Install. Approve the default destination 
directory, or browse to the correct directory.
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4 Click Next. The Report Deployment window opens. Accept the default to Deploy Reports; 
accept the default for application server name and port; type the username and password 
for the OVPI Application Server. 

5 Click Next. The Package Selection window opens. Click the check boxes for the packages 
you want to install. If you want to install all three report packs, click the check boxes for:

a SrvDsk_ChangeManagement 

b SrvDsk_ChangeManagement_Demo (optional)

c SrvDsk_HelpDesk

d SrvDsk_HelpDesk_Demo (optional)

e SLM_Integration

f SLM_Integration_Demo (optional)

6 Click Next. The Type Discovery window opens. Disable the default.

7 Click Next. The Selection Summary window opens.

8 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package installation complete message appears.

9 Click Done.

10 Restart OVPI Timer. 

On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.

b Select OVPI Timer from the list of services.

c From the Action menu, select Start.

On Unix, as root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Post-Installation Steps

Some post-installation steps are generic, applying to any Service Desk report packs, while 
some post-install steps are specific to one report pack. If you installed all three report packs, 
perform all of the following steps:

• Create a report connection object

• Give Service Desk the address of the DataFeeder server (OVPI)

• Set up the Reporting Administration workspace

• Set up full and incremental data exports to OVPI

• Export Dimension data to DimensionManager on OVPI (SLM Report Pack only)

• Use the OVPI Report form to configure user access to OVPI reports

• If desired, modify the defaults in SLM admin forms
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Give Service Desk a Destination for Exported Data

To configure the Service Desk client, perform these tasks:

• Task 1: Create a Report Connection Object that specifies OVPI server parameters.

• Task 2: Add the address of the DataFeeder server to the SLM Administration object.

• Task 3: Enable the Reporting Administration workspace.

Task 1: Create a Report Connection Object

You cannot export entities until you create an OVPI Report Connection object in Service Desk. 
Service Desk reads the OVPI Report Connection object to determine a destination for 
exported data.

Follow these steps to create an OVPI Report Connection:

1 Start the OpenView Console.

2 Right-click in the OV Configuration workspace group and select Add Workspace from the 
pop-up menu. The Add Workspace window opens.

3 Select the Object button, then scroll down the list of workspaces and select the OVPI Report 
Connection workspace. 

4 Click OK. OVPI Report Connection appears as a new workspace under OV Configuration.

5 Right-click the OVPI Report Connection workspace and select New OVPI Report Connection 
from the pop-up menu. 
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The OVPI Report Connection form opens.

6 Add entries in the Hostname, Username, Password, and Web Server Port fields.  

7 Do not change the values under Role Mapping.

8 Save and close the OVPI Report Connection form.

9 Load the updated parameters by restarting the Object Server. 

Once the OVPI Report Connection is established, Service Desk has a destination for exported 
data. If you installed the SLM Report Pack, perform the next task below, Task 2. This step will 
give Service Desk an address for DimensionManager and DataFeeder. If you did not install 
the SLM Report Pack, skip the next task and go directly to Task 3. 

You must have administrative privileges to make these changes; the default 
username for a user with administrative privileges is trendadm.

The Web Server Port must be the same as the OVPI web server port.
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Task 2: Add the address of the DataFeeder server to the SLM Administration object.

1 In the SLM Administrators group, select the SLM Administration workspace object. The 
SLM Administration form opens. 

If the SLM Administration object is not visible, right-click a group, select Add Workspace, 
and then select SLM Administration.

2 Click the Reporting Data Feeder tab in the SLM Administration form.

3 In the RDF Hostname field, enter the fully-qualified hostname of the OVPI server. 

Task 3: Enable the “Reporting Administration” workspace.

If the Reporting Administration workspace is not visible, you must add it to the OV 
Configuration group. Follow these steps: 

1 Right-click in the OV Configuration group and select Add Workspace from the pop-up 
menu. The Add Workspace window opens.

2 Select the Object button, select Reporting Administration, and click OK.

The Reporting Administration workspace appears under the OV Configuration group. Details 
about data export, for each report pack you installed, are visible from this view. 
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Check the Status of Reporting Daemons

Two reporting daemons, ovsdreport and ovsdslm, were installed by default when you installed 
Management Server software on the Service Desk server. To verify that the reporting 
daemons are running, use the ovc -status command. This command displays the status of 
every the following Management Server components:

• Control

• Login server

• Object server

• SLM OVSD Metric Adapter

• Certificate server

• Apache WebServer Service

• Communication Broker

• Service Desk Reporting

• Service Level Management

• Tomcat Servlet Container Service

If the reporting daemons are not running, start them by typing the ovc -start command 
from the command prompt:

ovc -start ovsdreport

If the Management Server is installed on multiple servers, you must unregister the reporting 
daemons on any server that you do not want to export data to OVPI. Follow these steps to 
unregister the reporting daemons on servers that are not exporting data to OVPI:

Windows:

C:\Program Files\HP OpenView\lbin\report\unregisterSDReporting.bat

Unix:

/opt/OV/lbin/report/unregisterSDReporting.sh

Export Help Desk Data to OVPI

The first export of Help Desk data initializes the OVPI database with all current Help Desk 
data. The second export is an incremental export that updates the OVPI database. If an 
incremental export fails, you can perform a full export to repopulate the OVPI database with 
all current Helpdesk module data. The full export can take several minutes, depending on the 
amount of data being exported.

Follow these steps to perform a full export of Help Desk data:

1 Login to the Service Desk server and start the OpenView Console.

2 In the OV Configuration group, select the Reporting Administration workspace. 

3 Right-click the HelpDesk module and select Full Export from the pop-up menu. 

You can monitor the status of the export in the Reporting Administration view. The export will 
take several minutes. While the export is in progress, the status is In Progress. When the 
export completes, the status changes to Completed. 
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Exporting Data by Running a Script

You have the option of exporting data by running the OvObsReportAdmin script.

Windows

C:\Program Files\HP OpenView\bin\OvObsReportAdmin.bat-moduleName=HelpDesk

Unix

/opt/OV/bin/OvObsReportAdmin.sh-moduleName=HelpDesk

Set Up an Incremental Export of Help Desk Data

An incremental export exports changes to Help Desk module data (service calls, problems, 
and incidents) that occurred since the previous export. Only one incremental export can run 
at one time. If two incremental exports are scheduled to run at the same time, they will run 
sequentially.

Follow these steps to set up incremental exports of the Help Desk module:

1 In the OV Configuration group, select the Reporting Administration workspace.

2 Right-click the HelpDesk module and select Edit from the pop-up menu. The Reporting 
Administration dialog box opens.

3 Copy the value that appears in the Last Successful Full Export field to the Start Date field. 
This is the time from which scheduling of incremental exports begins.

4 In the Export Period field, enter a value for the number of hours between incremental 
exports. The value you enter cannot be less than 1.

5 Check the Enable/Disable box.

Once the incremental export is enabled, you cannot run a full export. However, you can 
easily disable the incremental export by clearing this check box. Running a full export 
manually may be necessary if an error occurs during an incremental export and you want 
to repopulate the OVPI database.

6 Click File > Save & Close.

The incremental export process schedules the next export for the specified period. After the 
export runs, the Incremental Export Results tab shows details about the incremental export.

Export Change Manager Data to OVPI

The first export of Change Manager data initializes the OVPI database with all current 
Change Manager data. The second export is an incremental export that updates the OVPI 
database. If an incremental export fails, you can perform a full export to repopulate the OVPI 
database with all current Change Manager module data. The full export can take several 
minutes, depending on the amount of data being exported.

Follow these steps to perform a full export of Change Manager data:

1 Login to the Service Desk server and start OpenView Console.

2 In the OV Configuration group, select the Reporting Administration workspace. 

3 Right-click the Change Manager module and select Full Export from the pop-up menu. 

You can monitor the status of the export in the Reporting Administration view. The export will 
take several minutes. While the export is in progress, the status is In Progress. When the 
export completes, the status changes to Completed.
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Exporting Data by Running a Script

You have the option of exporting data by running the OvObsReportAdmin script.

Windows

C:\Program Files\HP OpenView\bin\OvObsReportAdmin.bat-moduleName=ChangeManagement

Unix

/opt/OV/bin/OvObsReportAdmin.sh-moduleName=ChangeManagement

Set Up an Incremental Export of Change Manager Data to OVPI

An incremental export exports changes to the Change Manager module data that occurred 
since the previous export. Only one incremental export can run at one time. If two 
incremental exports are scheduled to run at the same time, they will run sequentially.

Follow these steps to set up incremental exports of the Change Manager module:

1 In the OV Configuration group, select the Reporting Administration workspace.

2 Right-click the Change Manager module and select Edit from the pop-up menu. The 
Reporting Administration dialog box opens.

3 Copy the value that appears in the Last Successful Full Export field to the Start Date field. 
This is the time from which scheduling of incremental exports begins.

4 In the Export Period field, enter a value for the number of hours between incremental 
exports. The value you enter cannot be less than 1.

5 Enable incremental export by checking the Enable/Disable box.

Once the incremental export is enabled, you cannot run a full export. However, you can 
easily disable the incremental export by clearing this check box. Running a full export 
manually may be necessary if an error occurs during an incremental export and you want 
to repopulate the OVPI database.

6 Click File > Save & Close.

The incremental export process schedules the next export for the specified period. After 
the export runs, the Incremental Export Results tab shows details about the incremental 
export.

Export Dimension Data to OVPI

If you installed the SLM Report Pack, perform the following tasks: 

• Task 1: Verify that the BBC Communication Broker is running.

• Task 2: When necessary, export dimension data to Dimension Manager on OVPI

• Task 3: Check the Configuration and Logging Report

Task 1: Verify that the OpenView Communication Broker is running

Service Level Manager communications are under the control of the OpenView BBC 
Communication Broker. The Communication Broker must be running for SLM to operate 
correctly. To display a list of services that are running, type the following command from the 
command line:

ovc -status
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If the OV Communication Broker is not running, start it by typing the start command:

ovc -start ovbbccb

To start the SLM server, type this command:

ovc -start ovsdslm

Task 2: Export Dimension data to DimensionManager on OVPI

Follow these steps to export the service model to the OVPI dimension tables:

1 Run the following batch file:

$OvInstallDir/bin/ReportingConfigTool.bat

DimensionManager generates .csv files and stores them in the following directory:

{DPIPE_HOME}\data\ImportData\SLM\Dims

Every 5 minutes trend_timer calls a script; the script scans the Dims directory and 
imports data into OVPI property tables.

2 To verify that the import was successful, look for .csv files in this directory:

$DPIPE_HOME/packages/SLM_Integration/SLM_Integration.ap/csv/dims 

The files will be imported in about 5 minutes, so five minutes after the import starts, 
the.csv files will disappear from the dims directory. 

If you encounter a problem, see Chapter 11, Troubleshooting Dimension and Fact Data.

Modify the Defaults for Data Aging (SLM Report Pack Only)

Use the following forms to customize SLM report pack parameters:

• Evaluation Period Data Aging 

• Time Shift Data Aging

Follow these steps to open the SLM administration forms:

1 Select Start > Programs > HP OpenView Performance Insight > Management Console

2 In the Systems pane, upper left portion of the screen, click Objects.

3 The administration forms are listed under General Tasks. Click to open.

The export of fact data to OVPI is automatic, no user intervention is necessary. Each time the 
SLM core receives a metric value from a metric adapter, or each time there is a change in 
status for the facts managed by SLM, Service Desk sends fact data (including data pertaining 
to service hours, planned downtimes, and SLA evaluation periods) to DataFeeder on OVPI.
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Evaluation Period Data Aging

Specify the number of days information about a particular evaluation period is kept. The 
default is 365 days.

Time Shift Data Aging

Specify the number of days time shift information is kept. The default is 90 days.

Modify the Defaults for Logging Level

Each report pack provides a Logging Level form. Use the form to indicate the level of detail 
you want to see in log messages. Your options are:

• Errors

• Warnings

• Debug and Dev

 Follow these steps to locate the Logging Level form: 

1 Select Start > Programs > HP OpenView Performance Insight > Management Console

2 In the Systems pane, upper left portion of the screen, click Objects.
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3 The logging level form is listed under General Tasks. Click to open..
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4 Help Desk: Service Calls
Administration

• Configuration and Logging Report

Service Calls

• Average Duration of Service Calls

• Service Calls by Category

• Service Calls by Classification

• Service Calls Closed before Deadline by Category

• Service Calls Closed by Deadline

• Service Calls Closed on First Call

• Service Call Details

• Service Calls by Closure Code

• Incoming Service Calls (History)

• Incoming Service Calls (Recent)

Scheduling Reports

For details about using the Web Access Server to schedule reports, see Appendix B, 
Scheduling Reports.

UI and DB Rules for Closure Code

If you are familiar with Service Desk, you know that a closure code is assigned to a call when 
the call is closed. When a closure code is assigned, Service Desk automatically assigns a date 
and time to the closure code. The date and time assigned to the closure code is known as 
Actual Finish. There is a UI rule in Service Desk 4.5 that states that Actual Finish is the 
same as System Date. The UI rule reads as follows:

Actual Finish to system date when [status is] CLOSED

Service Desk 5.0/5.0 replaces the UI rule with a database rule. The impact of the database 
rule in Service Desk 5.0/5.1 is the same as the UI rule in Service Desk 4.5. If you upgraded 
from Service Desk 4.5 to Service Desk 5.0/5.1, the database rule is making the necessary 
association between Actual Finish and System Date, so there is no need to recreate the UI 
rule. 
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Configuration and Logging 

This report displays configuration information relating to data import for the Help Desk 
Report Pack. This report provides a list of the most recent log tarble entries for report pack 
internal procedures. The report is limited to the 200 most recernt entries.

Field/Drop-Down Description

Current logging level Options (one or any combination):
• Error
• Warning
• Information

Log entry Time the log entry was created
Component to which the log entry refers
Message
42 Chapter 4



Average Duration of Service Calls 

This report shows the average duration of service calls in days per classification, category, 
priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows service calls 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date field The start of the evaluation period.

End Date field The end of the evaluation period.

Total service calls table Total number of service calls and average duration 
(in days).

Classification table Number of service calls and average duration per 
classification.

Category table Number of service calls and average duration per 
category.

Priority table Number of service calls and average duration per 
priority code.

Tabbed area with bar charts Average duration of service calls at weekly, monthly 
or quarterly intervals (where applicable) within the 
evaluation period.
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Service Calls by Category 

This report shows the total number of service calls in the selected category with a further 
breakdown by impact, priority and classification.

The user selects start and end dates for the evaluation period. The report shows service calls 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Category table Number of service calls per category. Click the drill 
icon to display information for a particular category.

Total service calls table Total number of service calls.

Impact table Number of service calls opened per impact code in 
the selected category.

Priority table Number of service calls opened per priority code in 
the selected category.

Classification table Number of service calls opened per classification 
code in the selected category.

Tabbed area with bar charts Number of service calls at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and in the selected category.
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Service Calls by Classification 

This report shows the total number of service calls with the selected classification, with a 
further breakdown by category.

The user selects start and end dates for the evaluation period. The report shows service calls 
that were registered on or after the start date, and before the end date.

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Service Calls table Total number of service calls.

Classification table Number of service calls per classification. Click the 
drill icon to display information for a particular 
classification.

Category table Number of service calls per category with the 
selected classification.

Tabbed area with bar charts Number of service calls at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period and with the selected 
classification.
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Service Calls Closed Before Deadline by Category

This report shows the percentage of service calls closed before the deadline in the selected 
category, with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows service calls 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Service Calls closed table Total number of service calls closed
Number of service calls closed before deadline
Percentage closed before deadline
Number of service calls closed after deadline

Drill-down category table Per category:
• Number of service calls closed
• Number of service calls closed before deadline
• Percentage closed before deadline
• Number of service calls closed after deadline
Click the drill icon to display information for a 
particular category.

Closure code table Per closure code in the selected category:
• Number of service calls closed
• Number of service calls closed before deadline
• Percentage closed before deadline
• Number of service calls closed after deadline

Tabbed area with bar charts Number of service calls closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.
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Service Calls Closed Before Deadline

This report shows the percentage of service calls closed before the deadline per classification, 
category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows service calls 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date field The start of the evaluation period.

End Date field The end of the evaluation period.

Service Calls closed table Total number of service calls closed
Number of service calls closed before deadline
Percentage closed before deadline
Number of service calls closed after deadline

Classification table Per classification:
• Number of service calls closed
• Number of service calls closed before deadline
• Percentage closed before deadline
• Number of service calls closed after deadline

Category table Per category:
• Number of service calls closed
• Number of service calls closed before deadline
• Percentage closed before deadline
• Number of service calls closed after deadline

Priority table Per priority code:

• Number of service calls closed
• Number of service calls closed before deadline
• Percentage closed before deadline
• Number of service calls closed after deadline

Organization table Per organization:
• Number of service calls closed
• Number of service calls closed before deadline
• Percentage closed before deadline
• Number of service calls closed after deadline

Tabbed area with bar charts Number of service calls closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period.
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Service Calls Closed on First Call 

This report shows the percentage of service calls closed on the first call per classification, 
category, priority, and workgroup.

The user selects start and end dates for the evaluation period. The report shows service calls 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Service Calls closed table Total number of service calls closed
Number of service calls closed on first call
Percentage closed on first call

Classification table Per classification:
• Number of service calls closed
• Number of service calls closed on first call
• Percentage closed on first call

Category table Per category:
• Number of service calls closed
• Number of service calls closed on first call
• Percentage closed on first call

Priority table Per priority code:
• Number of service calls closed
• Number of service calls closed on first call
• Percentage closed on first call

Organization table Per organization:
• Number of service calls closed
• Number of service calls closed on first call
• Percentage closed on first call

Tabbed area with bar charts Number of service calls closed on first call at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.
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Service Calls Details 

This report shows the service call records which have been received for reporting and 
processing by the warehouse system. 

The user selects start and end dates for the evaluation period. The user can also set filters to 
reduce the selection and find specific cases. The primary table displays a limited set of rows 
(defaulted to 500 at most) and the lower table provides further details for the selected item.

Field/Drop-Down Description

Start Date The date the evaluation period started.

End Date The date the evaluation period ended.

Choose Category Limits the report to service calls in the selected 
category.

Choose Classification Limits the report to service calls with the selected 
classification.

Choose Workgroup Limits the report to service calls for the selected 
workgroup.

Choose Priority Limits the report to service calls with the selected 
priority code.

Choose Closure Code Limits the report to service calls with the selected 
closure code.

Choose Impact Limits the report to service calls with the selected 
impact.

Choose Organization Limits the report to service calls for the selected 
organization.

Change details Details of the service calls which meet the selected 
parameters. Select an object for further details.

Further details Further details of the selected object.
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Service Calls by Closure Code 

This report shows the total number of service calls in the selected category with a further 
breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows service calls 
that were registered on or after the start date, and before the end date.

Field Description

Start Date The date the evaluation period started.

End Date The date the evaluation period ended.

Drill-down category table Per category:
• Number of service calls
• Number of service calls closed before deadline
• Percentage of service calls closed before deadline
• Number of service calls closed after deadline
Click the drill icon to display information for a 
particular category.

Total service calls table Number of service calls closed before deadline
Total number of service calls
Percentage of service calls closed before deadline
Number of service calls closed after deadline

Closure code table Number of service calls per closure code in the selected 
category.

Tabbed area with bar charts Number of service calls closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.
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Incoming Service Calls (History)

This report shows the total number of service calls per classification, category, priority and 
organization.

The user selects start and end dates for the evaluation period. The report shows service calls 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date The date the evaluation period started.

End Date The date the evaluation period ended.

Service Calls table Total number of service calls opened.

Classification table Number of service calls opened per classification.

Category table Number of service calls opened per category.

Priority table Number of service calls opened per priority code.

Organization table Number of service calls opened per organization.

Tabbed area with bar charts Percentage of service calls opened at weekly, monthly 
or quarterly intervals (where applicable) within the 
evaluation period.
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Incoming Service Calls (Recent)

This report shows the total number of service calls per classification, category, priority and 
workgroup.

The user selects start and end dates and times for the evaluation period. The report shows 
service calls that were registered on or after the start date and time, and before the end date 
and time.

Field Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Start Hour field The start time of the evaluation period.

End Hour field The end time of the evaluation period.

Service Calls table Total number of service calls opened.

Classification table Number of service calls opened per classification.

Category table Number of service calls opened per category.

Priority table Number of service calls opened per priority code.

Organization table Number of service calls opened per organization.

Tabbed area with bar charts Number of service calls opened at hourly or daily 
intervals (where applicable) within the evaluation 
period.
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5 Help Desk: Incidents
Administration

• Configuration and Logging Report

Incidents

• Average Duration of Incidents

• Incidents by Category

• Incidents by Classification

• Incidents Closed Before Deadline by Category

• Incidents Closed by Deadline

• Incidents Closed on First Call

• Incident Details

• Incidents by Closure Code

• Incoming Incidents (History)

• Incoming Incidents (Recent)

Scheduling Reports 

For details about using the Web Access Server to schedule reports, see Appendix B, 
Scheduling Reports.
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Configuration and Logging

This report displays configuration information relating to Service Desk Reporting data 
import. It lists the most recent log table entries for report packs internal procedures. The 
report is limited to the 200 most recent entries.

Field/Drop-Down List Description

Current logging level Options (in any combination):

• Error

• Warning

• Information

Log entry Time the log entry was created
Component to which the log entry refers
Message
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Average Duration of Incidents

This report shows the average duration of incidents in days per classification, category, 
priority and workgroup. Once you select start and end dates for the evaluation period, the 
report shows incidents that were registered on or after the start date, and before the end date. 

Field/Drop-Down List Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Total incidents table Total number of incidents and average duration (in 
days).

Classification table Number of incidents and average duration per 
classification.

Category table Number of incidents and average duration per 
category.

Priority table Number of incidents and average duration per 
priority code.

Tabbed area with bar charts Average duration of incidents at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period.
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Incidents by Category

This report shows the total number of incidents in the selected category with a further 
breakdown by impact, priority and classification. Once you select start and end dates for the 
evaluation period, the report shows incidents that were registered on or after the start date, 
and before the end date. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Drill-down category table Number of incidents per category. Click the drill icon 
to display information for a particular category.

Incidents table Total number of incidents.

Impact table Number of incidents opened per impact code in the 
selected category.

Priority table Number of incidents opened per priority code in the 
selected category.

Classification table Number of incidents opened per classification in the 
selected category.

Tabbed area with bar charts Number of incidents at weekly, monthly or quarterly 
intervals (where applicable) within the evaluation 
period and in the selected category.
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Incidents by Classification

This report shows the total number of incidents with the selected classification, with a further 
breakdown by category. By selecting start and end dates for the evaluation period, you limit 
the report to incidents that were registered on or after the start date, and before the end date. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Incidents table Total number of incidents.

Drill-down classification table Number of incidents per classification. Click the drill 
icon to display information for a particular 
classification.

Category table Number of incidents per category with the selected 
classification.

Tabbed area with bar charts Number of incidents at weekly, monthly or quarterly 
intervals (where applicable) within the evaluation 
period and with the selected classification.
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Incidents Closed before Deadline by Category

This report shows the total number of incidents closed before the deadline in the selected 
category, with a further breakdown by closure code. The user selects start and end dates for 
the evaluation period. The report shows incidents that were registered on or after the start 
date, and before the end date.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Incidents closed table Total number of incidents closed
Number of incidents closed before deadline
Percentage closed before deadline
Number closed after deadline

Drill-down category table Per category:
• Number of incidents closed
• Number of incidents closed before deadline
• Percentage closed before deadline
• Number closed after deadline
Click the drill icon to display information for a 
particular category.

Closure code table Per closure code in the selected category:
• Number of incidents closed
• Number of incidents closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Tabbed area with bar charts Number of incidents closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.
Help Desk: Incidents 71



72 Chapter 5



Incidents Closed before Deadline

This report shows the percentage of incidents closed before the deadline per classification, 
category, priority and workgroup. By selecting start and end dates for the evaluation period, 
you limit the report to incidents that were registered on or after the start date, and before the 
end date. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Incidents closed table Total number of incidents closed
Number of incidents closed before deadline
Percentage closed before deadline
Number closed after deadline

Classification table Per classification:
• Number of incidents closed
• Number of incidents closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Category table Per category:
• Number of incidents closed
• Number of incidents closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Priority table Per priority code:
• Number of incidents closed
• Number of incidents closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Organization table Per organization:
• Number of incidents closed
• Number of incidents closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Tabbed area with bar charts Number of incidents closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period.
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Incidents Closed on First Call

This report shows the percentage incidents closed on the first call per classification, category, 
priority and workgroup. By selecting start and end dates for the evaluation period, you limit 
the report to incidents that were registered on or after the start date, and before the end date. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Incidents closed table Total number of incidents closed
Number of incidents closed on first call
Percentage closed on first call

Classification table Per classification:
• Number of incidents closed
• Number of incidents closed on first call
• Percentage closed on first call

Category table Per category:
• Number of incidents closed
• Number of incidents closed on first call
• Percentage closed on first call

Priority table Per priority code:
• Number of incidents closed
• Number of incidents closed on first call
• Percentage closed on first call

Organization table Per organization:
• Number of incidents closed
• Number of incidents closed on first call
• Percentage closed on first call

Tabbed area with bar charts Number of incidents closed on first call at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.
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Incidents Details

This report shows the incident records which have been received for reporting and processing 
by the warehouse system. The user selects start and end dates for the evaluation period. The 
user can also set filters to reduce the selection and find specific cases. The primary table 
displays a limited set of rows (defaulted to 500 at most) and the lower table provides further 
details for the selected item.

Field/drop Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Choose Category Limit the report to incidents in the selected category.

Choose Classification Limit the report to incidents with the selected 
classification.

Choose Workgroup Limit the report to incidents for the selected 
workgroup.

Choose Priority Limit the report to incidents with the selected priority 
code.

Choose Closure Code Limit the report to incidents with the selected closure 
code.

Choose Impact Limit the report to incidents with the selected impact.

Choose Organization Limit the report to incidents for the selected 
organization.

Change details list Details of the incidents which meet the selected 
parameters. Select an object for further details.

Further details list Further details of the selected object.
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Incidents by Closure Code

This report shows the total number of incidents in the selected category with a further 
breakdown by closure code. By selecting start and end dates for the evaluation period, you can 
limit the report to incidents that were registered on or after the start date, and before the end 
date. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Drill-down category table Per category:
• Number of incidents closed
• Number of incidents closed before deadline
• Percentage closed before deadline
• Number of incidents closed after deadline
Click the drill icon to display information in a 
particular category.

Total incidents table Total number of incidents closed before deadline
Number of incidents closed
Percentage closed before deadline
Number of incidents closed after deadline

Closure code table Number of incidents closed per closure code in the 
selected category.

Tabbed area with bar 
charts

Number of incidents closed before deadline at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period and in the selected 
category.
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Incoming Incidents (History)

This report shows the total number of incidents per classification, category, priority and 
organization. By selecting start and end dates for the evaluation period, you can limit the 
report to incidents that were registered on or after the start date, and before the end date.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Incidents table Total number of incidents opened.

Classification table Number of incidents opened per classification.

Category table Number of incidents opened per category.

Priority table Number of incidents opened per priority code.

Organization table Number of incidents opened per organization.

Tabbed area with bar charts Percentage of incidents opened at weekly, monthly 
or quarterly intervals (where applicable) within the 
evaluation period.
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Incoming Incidents (Recent)

This report shows the total number of incidents per classification, category, priority and 
workgroup. By selecting start and end dates, and start and end hours, for the evaluation 
period, you can limit the report to incidents that were registered on or after the start date and 
time, and before the end date and time. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Start Hour The start time of the evaluation period.

End Hour The end time of the evaluation period.

Incidents table Total number of incidents opened.

Classification table Number of incidents opened per classification.

Category table Number of incidents opened per category.

Priority table Number of incidents opened per priority code.

Organization table Number of incidents opened per organization.

Tabbed area with bar charts Number of incidents opened at hourly or daily 
intervals (where applicable) within the evaluation 
period.
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6 Help Desk: Problems
Administration

• Configuration and Logging Report

Problems

• Average Duration of Problems

• Problems by Category

• Problems by Classification

• Problems Closed before Deadline by Category

• Problems Closed by Deadline

• Problems Closed on First Call

• Problem Details

• Problems by Closure Code

• Incoming Problems (History)

• Incoming Problems (Recent)

Scheduling Reports

For details about using the Web Access Server to schedule reports, see Appendix B, 
Scheduling Reports.
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Configuration and Logging 

This report displays configuration information relating to Service Desk Reporting data 
import. It lists the most recent log table entries for report pack internal procedures. The 
report is limited to the 200 most recent entries.

Field Description

Current logging level Options:
• Error
• Warning
• Information
(or any combination)

Log entry Time the log entry was created
Component to which the log entry refers
Message
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Average Duration of Problems

This report shows the average duration of problems in days per classification, category, 
priority and workgroup. 

The user selects start and end dates for the evaluation period. The report shows problems 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date field The start of the evaluation period.

End Date field The end of the evaluation period.

Total problems table Total number of problems and average duration, 
measured in days.

Classification table Number of problems and average duration per 
classification.

Category table Number of problems and average duration per 
category.

Priority table Number of problems and average duration per 
priority code.

Tabbed area with bar charts Average duration of problems at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period.
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Problems by Category 

This report shows the total number of problems in the selected category with a further 
breakdown by impact, priority and classification.

The user selects start and end dates for the evaluation period. The report shows problems 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date field The start of the evaluation period.

End Date field The end of the evaluation period.

Drill-down category table Number of problems per category. Click the drill icon 
to display information for a particular category.

Total problems table Total number of problems.

Impact table Number of problems opened per impact code in the 
selected category.

Priority table Number of problems opened per priority code in the 
selected category.

Classification table Number of problems opened per classification code in 
the selected category.

Tabbed area with bar charts Number of problems at weekly, monthly or quarterly 
intervals (where applicable) within the evaluation 
period and in the selected category.
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Problems by Classification

This report shows the total number of problems with the selected classification, with a further 
breakdown by category.

The user selects start and end dates for the evaluation period. The report shows problems 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date field Drop-down list. The start date of the evaluation 
period.

End Date field Drop-down list. The end date of the evaluation 
period.

Problems table Total number of problems.

Drill-down classification 
table

Number of problems per classification. Click the drill 
icon to display information for a particular 
classification.

Category table Number of problems per category with the selected 
classification.

Tabbed area with bar charts Number of problems at weekly, monthly or quarterly 
intervals (where applicable) within the evaluation 
period and with the selected classification.
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Problems Closed before Deadline by Category 

This report shows the percentage of problems closed before the deadline in the selected 
category, with a further breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows problems 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Problems closed table Total number of problems closed
Number of problems closed before deadline
Percentage closed before deadline
Number closed after deadline

Drill-down category table Per category:
Number of problems closed
Number of problems closed before deadline
Percentage closed before deadline
Number closed after deadline
Click the drill icon to display information for a 
particular category.

Closure code table Per closure code in the selected category:
Number of problems closed
Number of problems closed before deadline
Percentage closed before deadline
Number closed after deadline

Tabbed area with bar charts Number of problems closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.
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Problems Closed by Deadline 

This report shows the percentage of problems closed before the deadline per classification, 
category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows problems 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Problems closed table Total number of problems closed
Number of problems closed before deadline
Percentage closed before deadline
Number closed after deadline

Classification table Per classification:
Number of problems closed
Number of problems closed before deadline
Percentage closed before deadline
Number closed after deadline

Category table Per category:
Number of problems closed
Number of problems closed before deadline
Percentage closed before deadline
Number closed after deadline

Priority table Per priority code:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Organization table Per organization:

• Number of problems closed

• Number of problems closed before deadline

• Percentage closed before deadline

• Number closed after deadline

Tabbed area with bar charts Number of problems closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period.
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Problems Closed on First Call 

This report shows the percentage of problems closed on the first call per classification, 
category, priority and workgroup.

The user selects start and end dates for the evaluation period. The report shows problems 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Problems closed table Total number of problems closed
Number of problems closed on first call
Percentage closed on first call

Classification table Per classification:
Number of problems closed
Number of problems closed on first call
Percentage closed on first call

Category table Per category:
Number of problems closed
Number of problems closed on first call
Percentage closed on first call

Priority table Per priority code:
Number of problems closed
Number of problems closed on first call
Percentage closed on first call

Organization table Per organization:
Number of problems closed
Number of problems closed on first call
Percentage closed on first call

Tabbed area with bar charts Number of problems closed on first call at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.
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Problems Details

This report shows the problem records which have been received for reporting and processing 
by the warehouse system. 

The user selects start and end dates for the evaluation period. The user can also set filters to 
reduce the selection and find specific cases. The primary table displays a limited set of rows 
(defaulted to 500 at most) and the lower table provides further details for the selected item.

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Choose Category Limit the report to a category.

Choose Classification Limit the report to a classification.

Choose Workgroup Limit the report to a workgroup.

Choose Priority Limit the report to a priority code.

Choose Closure Code Limit the report to a closure code.

Choose Impact Limit the report to an impact.

Choose Organization Limit the report to an organization.

Change details list Details of the problems which meet the selected 
parameters. Select an object for further details.

Further details list Further details of the selected object.
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Problems by Closure Code 

This report shows the total number of problems for the selected category with a further 
breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows problems 
that were registered on or after the start date, and before the end date. 

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Drill-down category table Per category:
Number of problems closed
Number of problems closed before deadline
Percentage closed before deadline
Number of problems closed after deadline
Click the drill icon to display information for a 
particular category.

Total problems table Total number of problems closed
Number of problems closed before deadline
Percentage closed before deadline
Number of problems closed after deadline

Closure code table Number of problems per closure code in the selected 
category.

Tabbed area with bar charts Number of problems closed before deadline at 
weekly, monthly or quarterly intervals (where 
applicable) within the evaluation period and in the 
selected category.
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Incoming Problems (History)

This report shows the total number of problems per classification, category, priority and 
organization.

The user selects start and end dates for the evaluation period. The report shows problems 
that were registered on or after the start date, and before the end date. 

Filed/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Problems table Total number of problems opened.

Classification table Number of problems opened per classification.

Category table Number of problems opened per category.

Priority table Number of problems opened per priority code.

Organization table Number of problems opened per organization.

Tabbed area with bar charts Percentage of problems opened at weekly, monthly or 
quarterly intervals (where applicable) within the 
evaluation period.
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Incoming Problems (Recent) 

This report shows the total number of problems per classification, category, priority and 
workgroup.

The user selects start and end dates and times for the evaluation period. The report shows 
problems that were registered on or after the start date and time, and before the end date and 
time. 

Field/Drop-Down Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Start Hour The start time of the evaluation period.

End Hour The end time of the evaluation period.

Problems table Total number of problems opened.

Classification table Number of problems opened per classification.

Category table Number of problems opened per category.

Priority table Number of problems opened per priority code.

Organization table Number of problems opened per organization.

Tabbed area with bar charts Number of problems opened at hourly or daily 
intervals (where applicable) within the evaluation 
period.
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7 Change Management Reports
Administration

• Configuration and logging Report

Change Management

• Average Duration of Changes

• Changes by Category

• Changes by Classification

• Changes Closed before Deadline by Category

• Changes Closed by Deadline

• Changes Closed on First Call

• Changes Details

• Changes by Closure Code

• Incoming Changes (History)

• Incoming Changes (Recent)

Scheduling Reports

For details about using the Web Access Server to schedule reports, see Appendix B, 
Scheduling Reports.
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Configuration and Logging

This report displays configuration information relating to Service Desk Reporting data 
import. It lists the most recent log table entries for report pack internal procedures. The 
report is limited to the 200 most recent entries.

Field/Drop-Down Description

Current logging level Options (one or any combination):
• Error
• Warning
• Information

Log entries Time the log entry was created
Component to which the log entry refers
Message
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Average Duration of Changes

This report shows the total number of changes, and the average duration of changes, in days. 
You can view these statistics on by classification, by category, by priority code, and by 
workgroup. Once you select start and end dates for the evaluation period, the report shows 
changes that were registered between the start date and the end date. The bar charts at the 
bottom of the report show how the duration of changes has fluctuated from week to week, 
month to month, and quarter to quarter. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Total changes table Total number of changes and average duration (in 
days).

Classification table Number of changes and average duration per 
classification.

Category table Number of changes and average duration per 
category.

Priority table Number of changes and average duration per 
priority code.

Tabbed area with bar charts Average duration of changes at weekly, monthly or 
quarterly intervals (where applicable).
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Changes by Category

This report shows the total number of changes in the selected category, with a further 
breakdown by impact, priority and classification.

Once you select start and end dates for the evaluation period, the report shows changes that 
were registered on or after the start date, and before the end date.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Category table Number of changes per category. Click the drill icon 
to display information for a particular category.

Total changes table Total number of changes.

Impact table Number of changes opened per impact code in the 
selected category.

Priority table Number of changes opened per priority code in the 
selected category.

Classification table Number of changes opened per classification code in 
the selected category.

Tabbed area with bar charts Number of changes at weekly, monthly or quarterly 
intervals (where applicable) within the evaluation 
period and in the selected category.
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Changes by Classification

This report shows the total number of changes by selected classification, with a further 
breakdown by category. 

Once you select start and end dates for the evaluation period, the report shows changes that 
were registered on or after the start date, and before the end date. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Changes table Total number of changes.

Classification table Number of changes per classification. Click the drill 
icon to display information for a particular 
classification.

Category table Number of changes per category with the selected 
classification.

Tabbed area with bar charts Number of changes at weekly, monthly or quarterly 
intervals (where applicable) within the evaluation 
period and with the selected classification.
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Changes Closed before Deadline by Category

This report shows the percentage of changes closed before the deadline in the selected 
category, with a further breakdown by closure code.

Once you select start and end dates for the evaluation period, the report shows changes that 
were registered on or after the start date, and before the end date. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Changes closed table Total number of changes closed
Number of changes closed before deadline
Percentage closed before deadline
Number closed after deadline

Category table Per category:
• Number of changes closed
• Number of changes closed before deadline
• Percentage closed before deadline
• Number closed after deadline
• Click the drill icon to display information for a 

particular category.

Closure code table Per closure code in the selected category:
• Number of changes closed
• Number of changes closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Tabbed area with bar charts Number of changes closed before deadline at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period and in the selected 
category.
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Changes Closed before Deadline 

This report shows the percentage of changes closed before the deadline per classification, 
category, priority and workgroup.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Changes closed table Total number of changes closed
Number of changes closed before deadline
Percentage closed before deadline
Number closed after deadline

Classification table Per classification:
• Number of changes closed
• Number of changes closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Category table Per category:
• Number of changes closed
• Number of changes closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Priority table Per priority code:
• Number of changes closed
• Number of changes closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Organization table Per organization:
• Number of changes closed
• Number of changes closed before deadline
• Percentage closed before deadline
• Number closed after deadline

Tabbed area with bar charts Number of changes closed before deadline at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.
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Changes Closed on First Call 

This report shows the percentage of changes closed on the first call per classification, category, 
priority and workgroup. 

Once you select start and end dates for the evaluation period, and select an organization, the 
report shows:

• Number of changes closed on first call by classification, category, priority and workgroup

• Total number of changes opened during selected timeframe

• Total number closed on first call

• Percentage closed on first call

• Weekly, monthly, and quarterly graphs of total changes closed on first call 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Changes closed table Total number of changes closed
Number of changes closed on first call
Percentage closed on first call

Classification table Per classification:
• Number of changes closed
• Number of changes closed on first call
• Percentage closed on first call

Category table Per category:
• Number of changes closed
• Number of changes closed on first call
• Percentage closed on first call

Priority table Per priority code:
• Number of changes closed
• Number of changes closed on first call
• Percentage closed on first call

Organization table Per organization:
• Number of changes closed
• Number of changes closed on first call
• Percentage closed on first call

Tabbed area with bar charts Number of changes closed on first call at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period.
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Changes Details

This report shows the change records which have been received for reporting and processing 
by the warehouse system. Only recent changes are available. 

The user selects start and end dates for the evaluation period. The user can also set filters to 
reduce the selection and find specific cases. The primary table displays a limited set of rows 
(defaulted to 50) and the lower table provides further details for the selected item.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Choose Category Limit the report to changes in the selected category.

Choose Classification Limit the report to changes with the selected 
classification.

Choose Workgroup Limit the report to changes for the selected 
workgroup.

Choose Priority Limit the report to changes with the selected priority 
code.

Choose Closure Code Limit the report to changes with the selected closure 
code.

Choose Impact Limit the report to changes with the selected impact.

Choose Organization Limit the report to changes for the selected 
organization.

Change details Details for changes that meet the selected 
parameters. Select an object for further details.

Further details Further details about the selected object.
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Changes by Closure Code

This report shows the total number of changes in the selected category, with a further 
breakdown by closure code.

The user selects start and end dates for the evaluation period. The report shows changes that 
were registered on or after the start date, and before the end date.

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Category table Per category:
• Number of changes
• Number of changes closed before deadline
• Percentage closed on before deadline
• Number of changes closed after deadline
• Click the drill icon to display information for a 

particular category.

Total changes table Total number of changes
Number of changes closed before deadline
Percentage closed on before deadline
Number of changes closed after deadline

Closure code table Number of changes per closure code in the selected 
category.

Tabbed area with bar charts Number of changes closed before deadline at weekly, 
monthly or quarterly intervals (where applicable) 
within the evaluation period and for the selected 
category.
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Incoming Changes (History)

This report shows the total number of changes per classification, category, priority and 
organization. 

The user selects start and end dates for the evaluation period. The report shows changes that 
were registered on or after the start date, and before the end date. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Changes table Total number of changes opened.

Classification table Number of changes opened per classification.

Category table Number of changes opened per category.

Priority table Number of changes opened per priority code.

Organization table Number of changes opened per organization.

Tabbed area with bar charts Percentage of changes opened at weekly, 
monthly or quarterly intervals (where 
applicable) within the evaluation period.
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Incoming Changes (Recent)

This report shows the total number of changes per classification, category, priority and 
workgroup. Once you select start and end dates and times for the evaluation period, the 
report shows changes that were registered on or after the start date and time, and before the 
end date and time. 

Field/Drop-Down List Description

Start Date The start of the evaluation period.

End Date The end of the evaluation period.

Start Hour The start time of the evaluation period.

End Hour The end time of the evaluation period.

Changes table Total number of changes opened.

Classification table Number of changes opened per classification.

Category table Number of changes opened per category.

Priority table Number of changes opened per priority code.

Organization table Number of changes opened per organization.

Tabbed area with bar charts Number of changes opened at hourly or daily 
intervals (where applicable) within the evaluation 
period.
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8 SLM Reports
Administration

Configuration and Logging Report

Customer Business Manager Reports

• SLA Overview for Customer Business Manager

• SLA Detail for Customer Business Manager

• Service Detail for Customer Business Manager

• SLO Detail for Customer Business Manager

Customer Relationship Manager Reports

• SLA Overview for Customer Relationship Manager

• SLA Detail for Customer Relationship Manager

• Service Detail for Customer Relationship Manager

• SLO Detail for Customer Relationship Manager

Service Manager Reports

• Service Overview for Service Manager

• Service Detail for Service Manager

• Configuration Item Detail for Service Manager

Scheduling Reports 

For details about using the Web Access Server to schedule reports, see Appendix B, 
Scheduling Reports.
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Configuration and Logging 

This report displays configuration information relating to data import for the SLM Report 
Pack. Use this report to locate a list of the most recent log table entries for report pack 
internal procedures. The report is limited to the 200 most recernt entries.

Field/Drop-Down Description

Current logging level Options (one or any combination):
• Error
• Warning
• Information

Log entry Time the log entry was created
Component to which the log entry refers
Message
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SLA Overview for Customer Business Manager

This report provides overview information about all service level agreements, related to the 
target user, in a specific reporting interval.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with 
customer relationship manager. If the CRM is not 
specified, all service level agreements. 
Link: SLA Detail for Customer Business Manager

CRM Customer relationship manager associated with the 
service level agreement

Service Level Service level for this agreement

Current Status Status of the agreement; options are green (complies 
with the objective) or red (fails to comply with the 
objective).

Drill-down Click the drill-down icon to display details about the 
services associated with a particular SLA.

Evaluation Periods

Selection box Evaluation period for the selected SLA

SLA Summary for Current Period

Start Date Start date for the evaluation period

End Date End date for the evaluation period

Latest Status Latest compliance status for the selected evaluation 
period (Compliance or Violation)

Latest Status Date Date when the latest compliance status was calculated

Services and Service Level Objectives

Service Service related to the service level agreement

Compliance SLO Service metric related to the service

Achieved Compliance Compliance value achieved by the service metric for the 
selected evaluation period

Compliance Objective Compliance violation threshold value for the service 
metric

Compliance Status Compliance status of the service metric for the selected 
evaluation period (Compliance or Violation)
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SLA Detail for Customer Business Manager

This report shows compliance status details for a particular service level agreement during a 
specific reporting interval.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with the 
customer relationship manager. If the CRM is not 
specified, all service level agreements. 
Link: SLO Detail for Customer Business Manager

CRM Customer relationship manager associated with the 
service level agreement.

Service Level Service level for the SLA.

Current Status Status of the SLA for the current evaluation period; 
options are green (compliance) or red (violation).

Drill-down Click the drill-down icon to display information for a 
particular service level agreement.

Evaluation Periods

Selection box Evaluation periods for the selected SLA

SLA Summary for Current Period

Start Date Start of the evaluation period.

End Date End of the evaluation period.

Latest Status Latest compliance status for the selected SLA for the 
selected evaluation period.

Latest Status Date Date and time when the latest compliance status of the 
drilled-down service level agreement was calculated.

Services

Selection box Services associated with the service level agreement.

Service Summary for Current Period

Description Description of the selected service.

Latest Compliance Status Latest compliance status of the selected service for the 
selected evaluation period.

Latest Status Date Date when the latest status was calculated for the 
selected evaluation period.
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Service Compliance Status 
Distribution

Bar chart showing ratio of violation status to 
compliance status for each day during the evaluation 
period.

Service Infrastructure 
Availability Status 
Distribution

Bar chart showing ratio of achieved, not achieved, and 
not yet calculated for each day during the evaluation 
period.

Field Description
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Service Detail for Customer Business Manager

This report provides service metric status details associated with a specific service.

Field Description

Active SLA List

SLA Service level agreements associated with the 
customer relationship manager. If the CRM is not 
specified, all service level agreements.

CRM Customer relationship manager associated with the 
service level agreement

Service Level Service level for the service level agreement.

Current Status Status of the SLA; green (compliance), yellow 
(jeopardy), or red (violation).

Drill-down Click the drill-down icon to display information for a 
particular service level agreement.

Evaluation Periods

Selection box Evaluation periods for the service level agreement.

SLA Summary for Current Period

Start Date Start of the evaluation period.

End Date End of the evaluation period.

Latest Status Latest compliance status of the drilled-down service 
level agreement for the selected evaluation period

Latest Status Date Date and time when the latest compliance status of 
the drilled-down service level agreement was 
calculated

Services

Selection box Services associated with the service level agreement

Service Summary for Current Period

Description Description of the selected service

Latest Compliance Status Latest compliance status of the selected service for 
the selected evaluation period

Latest Status Date Date when the latest status was calculated for the 
selected evaluation period

Service Metric List for Current Service

Name Name of the service metric

Latest Compliance Latest compliance status of the service metric
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Latest Date Date and time when the latest service metric status 
was calculated

Drill-down Click the drill-down button to display metric value 
information for a particular service metric

Metric Value Graphical display of maximum metric values, 
minimum metric values, and compliance metric 
values against time for the drilled-down service 
metric

Field Description
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SLO Detail for Customer Business Manager

This report provides information about the service level objectives associated with a service.

Field Description

Active SLA List

SLA List of service level agreements associated with the 
customer relationship manager. If the CRM is not 
specified, all service level agreements.

CRM Customer relationship manager associated with the 
service level agreement.

Service Level Service level for the service level agreement.

Current Status Status of the SLA; options are green (compliance), 
yellow (jeopardy), or red (violation).

Drill-down Click the drill-down icon to display information for a 
particular service level agreement.

Evaluation Periods

Selection box Evaluation periods for the service level agreement.

SLA Summary for Current Period

Start Date Start of the evaluation period.

End Date End of the evaluation period.

Latest Status Latest compliance status of the drilled-down service 
level agreement for the selected evaluation period

Latest Status Date Date and time when the latest status was calculated.

Services

Selection box Services associated with the service level agreement

Service Summary for Current Period

Description Description of the selected service

Latest Compliance Status Latest compliance status of the selected service for 
the selected evaluation period

Latest Status Date Date when the latest status was calculated for the 
selected evaluation period

Service Metric List for Current Service

Name Name of the service metric

Compliance Status Compliance status of the service metric

Category Category of service metric; options are Standard, 
Aggregated, or Infrastructure.
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Achieved Compliance Aggregated compliance value achieved by the service 
metric

Objective Compliance Compliance violation threshold value for the service 
metric.

Drill-down Click the drill-down icon to display metric value 
information for a particular service metric.

Service Metric Compliance Percentage Distribution

Service Metric Compliance 
Percentage Distribution

Graph showing the compliance percentage for each 
day during the evaluation period.

Field Description
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SLA Overview for Customer Relationship Manager

This report provides overview information about all service level agreements that are related 
to the target user in a specific reporting interval.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with the 
customer business manager. If the CBM is not 
specified, all service level agreements. 
Link: SLA Detail for Customer Relationship Manager

CRM Customer relationship manager associated with the 
service level agreement

Service Level Service level for the service level agreement

Current Status Status of the service level agreement for the current 
evaluation period; options are Compliance, Jeopardy, 
Violation.

Predictive Status Status predicted to be reached at the end of the 
current evaluation period’ options are Compliance, 
Jeopardy, Violation.

Drill-down Click the drill-down icon to display information for a 
particular service level agreement

Evaluation Periods

Selection box Evaluation periods for the service level agreement.

SLA Summary for Current Period

Start Date Start date of the evaluation period

End Date End date of the evaluation period

Latest Status Latest status for the selected evaluation period; 
options are Compliance, Jeopardy, or Violation.

Latest Status Date Date when the latest status was calculated.

Services and Service Level Objectives

Service Service related to the service level agreement.

Compliance SLO Service metric related to the service.

Compliance Objective Compliance violation threshold value for the service 
metric.

Actual Compliance Compliance value achieved by the service metric for 
the selected evaluation period.

Compliance Status Status of the service metric for the selected evaluation 
period; options are Compliance, Jeopardy, or Violation.
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SLA Detail for Customer Relationship Manager

This report shows compliance status details for a particular service level agreement during a 
specific reporting interval.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with the 
customer relationship manager; if the CRM is not 
specified, all service level agreements. 
Link: SLO Detail for Customer Relationship Manager

CRM Customer relationship manager associated with the 
service level agreement

Service Level Service level for the service level agreement

Current Status Status of the service level agreement for the current 
evaluation period; options are Compliance, Jeopardy, 
Violation.

Predictive Status Status predicted to be reached at the end of the 
current evaluation period; options are Compliance, 
Jeopardy, Violation.

Drill-down Click the drill-down icon to display information for a 
particular service level agreement.

Evaluation Periods

Selection box Evaluation periods for the service level agreement

SLA Summary for Current Period

Start Date Start of the evaluation period.

End Date End of the evaluation period.

Latest Status Latest status for the selected evaluation period.

Latest Status Date Date and time when the latest status was calculated

Services

Service (selection box) Services associated with the service level agreement

Service Summary for Current Period

Description Description of the selected service

Latest Compliance Status Latest compliance status of the selected service for the 
selected evaluation period
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Latest Status Date Date when the latest status was calculated for the 
selected evaluation period

Service Compliance Status 
Distribution

Bar chart showing ratio of Compliance, Jeopardy, and 
Violation for each day during the evaluation period.

Service Infrastructure 
Availability Status 
Distribution

Bar chart showing ratio of Achieved, Not Achieved, 
and Not Yet Calculated for availability for each day 
during the evaluation period.

Field Description
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Service Detail for Customer Relationship Manager

This report provides service metric status details associated with a specific service.

Field Description

Active SLA List

SLA List of service level agreements associated with the 
customer relationship manager (if specified), or all 
service level agreements (if customer relationship 
manager not specified).

CRM Customer relationship manager associated with the 
service level agreement

Service Level Service level for the service level agreement

Current Status Compliance status of the service level agreement for 
the current evaluation period (Compliance, 
Jeopardy, or Violation)

Predictive Status Compliance status predicted to be reached at the end 
of the current evaluation period (Compliance, 
Jeopardy, or Violation)

Drill-down Click the drill-down button to display information for 
a particular service level agreement

Evaluation Periods

Evaluation Period (selection 
box)

Evaluation periods for the drilled-down service level 
agreement

SLA Summary for Current Period

Start Date Start date of the selected evaluation period

End Date End date of the selected evaluation period

Latest Status Latest compliance status of the drilled-down service 
level agreement for the selected evaluation period

Latest Status Date Date and time when the latest compliance status of 
the drilled-down service level agreement was 
calculated

Services

Selection box Services associated with the service level agreement

Service Summary for Current Period

Description Description of the selected service

Latest Compliance Status Latest compliance status of the selected service for 
the selected evaluation period

Latest Status Date Date when the latest compliance status was 
calculated for the selected evaluation period
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Service Metric List for Current Service

Name Name of the service metric

Latest Compliance Latest compliance status of the service metric

Latest Date Date and time when the latest service metric 
compliance status was calculated

Drill-down Click the drill-down button to display metric value 
information for a particular service metric

Metric Value Graphical display of maximum metric values, 
minimum metric values, and compliance metric 
values against time for the drilled-down service 
metric

Field Description
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SLO Detail for Customer Relationship Manager

This report provides information about the service level objectives associated with a service.

Field Description

Active SLA List

SLA (linked) List of service level agreements associated with the 
customer business manager. If the CBM is not 
specified, all service level agreements. 
Link: SLA Detail for Customer Relationship Manager

CRM Customer relationship manager associated with the 
service level agreement

Service Level Service level for the service level agreement

Current Status Status of the service level agreement for the current 
evaluation period; options are Compliance, Jeopardy, 
Violation.

Predictive Status Status predicted to be reached at the end of the 
current evaluation period; options are Compliance, 
Jeopardy, Violation.

Drill-down Click the drill-down icon to display information for a 
particular service level agreement

Evaluation Periods

Selection box Evaluation periods for the drilled-down service level 
agreement

SLA Summary for Current Period

Start Date Start of the evaluation period.

End Date End of the evaluation period.

Latest Status Latest status of the service level agreement for the 
selected evaluation period

Latest Status Date Date and time when the latest compliance status of 
the drilled-down service level agreement was 
calculated

Services

Selection box Services associated with the service level agreement

Service Summary for Current Period

Description Description of the selected service

Latest Compliance Status Latest compliance status of the selected service for the 
selected evaluation period

Latest Objective Status Latest objective status of the selected service for the 
selected evaluation period
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Latest Status Date Date when the latest status was calculated

Service Metric List for Current Service

Name Name of the service metric

Compliance Status Compliance status of the service metric

Category Category of service metric (Standard, Aggregated, or 
Infrastructure)

Achieved Compliance Aggregated compliance value achieved by the service 
metric

Objective Compliance Compliance violation threshold value for the service 
metric.

Drill-down Click the drill-down icon to display metric value 
information for a particular service metric

Service Metric Compliance Percentage

Ref Name of compliance threshold

Objective The objective threshold value and operator for the 
compliance threshold

Severity The severity of the compliance threshold

Service Metric Compliance Percentage Distribution

Service Metric Compliance 
Percentage Distribution

Graphical display of achieved compliance values over 
the selected evaluation period.

Field Description
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Service Overview for Service Manager

This report provides a list of all services that are managed by target user, together with 
summary information.

Field Description

Active Service List

Service Name of the service. Click the service to link to the 
Service Detail report (Service Manager).

Description Description of the service

Service Manager Service manager assigned to the service

Drill-down Click the drill-down button to display information for 
a particular service

Associated SLA (selection 
box)

Service level agreements associated to the 
drilled-down service

Associated Service Compliance Status

Last Compliance Status Traffic light indicator of the last known compliance 
status of the service (Compliant, Jeopardy, and 
Violation) and the date and time the status was 
calculated

Last Predictive Compliance 
Status

Traffic light indicator of the last known predictive 
compliance status of the service (Compliant, 
Jeopardy, or Violation) and the date and time the 
status was calculated.

Service Availability Status Distribution

Duration selection box Duration for the graphs below showing the service 
availability in sections of Achieved, Not Achieved, 
and Not Yet Computed according to the time period 
chosen. You can choose to view the graphs in 
minutes, hours or days. The periods during which 
the service is in the state Not In Service according to 
the service hours schedules appear as dark areas in 
the bar charts.
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5-Minutely Service 
Availability

Service availability at 5-minute intervals over the 
default duration (last two complete hours plus the 
current hour up to the present moment), or the 
duration specified using the Edit Graph button.

Hourly Service Availability Service availability at hourly intervals over the 
default duration (last complete day plus the current 
day up to the present moment), or the duration 
specified using the Edit Graph button.

Daily Service Availability Service Availability values at daily intervals over the 
default duration (last complete month plus the 
current month up to the present moment), or the 
duration specified using the Edit Graph button.

Field Description
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Service Detail for Service Manager

This report provides lists and links to underpinning services and configuration items, plus 
information about service metrics for the selected service.

Field Description

Service Information

Service Name of the service 

Service Manager Service manager assigned to the service

Last Availability... Most-recently calculated availability for the service

... for SLA Service level agreement associated with the service

Drill-down Click the drill-down button to display information for 
a particular service

Underpinning Service List

Service Name of the subordinate service

Service Manager Service manager assigned to the service

Last Availability Status Most-recently calculated availability for the service

Underpinning Configuration Item List

Configuration Item Name of the subordinate configuration item

Last Availability Status Most-recently calculated availability for the CI

Service Metric List

Metric Name Name of the metric

Description Description of the metric

Unit Units for the metric data values

Category Category of metric (for example, Standard)

Metric Value Distribution

5-Minutely Metric Value Metric values at 5-minute intervals over the default 
duration (last two complete hours plus the current 
hour up to the present moment), or the duration 
specified using the Edit Graph button.

Hourly Metric Value Metric values at hourly intervals over the default 
duration (last complete day plus the current day up 
to the present moment), or the duration specified 
using the Edit Graph button.

Daily Metric Value Metric values at daily intervals over the default 
duration (last complete month plus the current 
month up to the present moment), or the duration 
specified using the Edit Graph button.
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Configuration Item Detail for Service Manager

This report provides detailed information about a given configuration item. The target user 
typically links to this report from the Service Detail for Customer Relationship Manager 
report.

Field Description

Configuration Item Information

Name Name of the configuration item

Latest Availability... Most-recently calculated current availability status 
for the configuration item

... for SLA Service level agreement associated with the 
configuration item

Service Level Service level associated with the service level 
agreement

Customer Service receiver associated with the service level 
agreement

Drill-down Click the drill-down button to display information for 
a particular combination of configuration item and 
service level agreement

Configuration Item Availability Distribution

5-Minutely CI Availability CI availability at 5-minute intervals over the default 
duration (last two complete hours plus the current 
hour up to the present moment), or the duration 
specified using the Edit Graph button 

Hourly CI Availability CI availability at hourly intervals over the default 
duration (last complete day plus the current day up 
to the present moment), or the duration specified 
using the Edit Graph button

Daily CI Availability CI availability at daily intervals over the default 
duration (last complete month plus the current 
month up to the present moment), or the duration 
specified using the Edit Graph button

Configuration Item Metric List

Metric Name Name of the metric

Metric Unit Units for the metric data values

Metric Value Distribution
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5-Minutely Metric Value Metric values at 5-minute intervals over the default 
duration (last two complete hours plus the current 
hour up to the present moment), or the duration 
specified using the Edit Graph button

Hourly Metric Value Metric values at hourly intervals over the default 
duration (last complete day plus the current day up 
to the present moment), or the duration specified 
using the Edit Graph button

Daily Metric Value Metric values at daily intervals over the default 
duration (last complete month plus the current 
month up to the present moment), or the duration 
specified using the Edit Graph button

Field Description
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9 Troubleshooting the SD45 Datapipes
This chapter covers the following topics:

• Troubleshooting installation problems

• Verifying that views were created

• Verifying that data is being collected

Installation Problems

If problems come up during installation of one or both SD45 datapipes, the most likely cause 
of the problem is an unsuccessful connection to the Service Desk 4.5 database. 

Check the following two logs for errors:

{DPIPE_HOME}/log/report_*.log 

{DPIPE_HOME}/log/trend.log

If there are problems with Serverfile.txt in the {DPIPE_HOME}/data/ directory, trend.log will 
contain the following errors: 

2006-05-02 13:56:15:000,India Standard 
Time,+05:30,trend_proc_launch,,DEF_ERROR,6084,6012,0,"The following command exited with 
code 1: C:/OVPI/jre/bin/java  -classpath "C:/OVPI/lib/SD.jar;C:/OVPI/lib/pidb.jar;C:/OVPI/
lib/jconn2d.jar;C:/OVPI/lib/classes12.jar;C:/OVPI/lib/Opta2000.jar;" SD C:/OVPI c change"

2006-05-02 13:56:15:000,India Standard 
Time,+05:30,trend_proc,,DEF_ERROR,6012,5708,0,"Child terminated with exit code 1"

2006-05-02 13:56:16:000,India Standard 
Time,+05:30,trend_proc_launch,,DEF_ERROR,4688,6336,0,"The following command exited with 
code 1: C:/OVPI/jre/bin/java  -classpath "C:/OVPI/lib/SD.jar;C:/OVPI/lib/pidb.jar;C:/OVPI/
lib/jconn2d.jar;C:/OVPI/lib/classes12.jar;C:/OVPI/lib/Opta2000.jar;" SD C:/OVPI c help"

2006-05-02 13:56:16:000,India Standard 
Time,+05:30,trend_proc,,DEF_ERROR,6336,6020,0,"Child terminated with exit code 1“

If the one or both datapipes are unable to connect to the Service Desk 4.5 database, trend.log 
will contain the following errors:

2006-05-03 15:33:20:843,GMT+05:30 Standard, 05:30 , , , ERROR, 0, 0, 0, Io exception: The 
Network Adapter could not establish the connection [ErrorCode:17002]
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Were Views Created?

Installing the SD45 datapipes creates database views. Follow these steps to verify that view 
creation was successful:

1 Login to the Service Desk 4.5 database.

2 Run the following commands at the sql prompt:

Oracle:

• desc ITSM_INCIDENTS_V

• desc ITSM_PROBLEMS_V

• desc ITSM_SERVICECALLS_V

• desc ITSM_CHANGES_V

MS SQL:

• sp_help ITSM_INCIDENTS_V

• sp_help ITSM_PROBLEMS_V

• sp_help ITSM_SERVICECALLS_V

• sp_help ITSM_CHANGES_V

If the views were created, the Service Desk database will display a description of each view.

Why View Creation Might Fail

If views were not created, you probably made a mistake when you tried to configure OVPI to 
recognize the Service Desk database an external database. As explained in Chapter 2, an 
incorrect entry in the database connection information window will cause the connection to 
fail, making it impossible to create views.

Verify the following:

1 Check that there is a Serverfile.txt file in the {DPIPE_HOME}/data/ directory and that 
the entries in this file are correct. 

2 Check for installation errors in trend.log.

3 The Service Desk server must be up when you install the datapipes. So, just before 
installing the datapipes, check for database connectivity by pressing the Test Connection 
button in Management Console.

4 You cannot create views unless your username has that privilege. Verify that your 
username was granted sufficient privileges. Run the following commands at command 
prompt in OVPI system:

Windows:

{DPIPE_HOME}\jre\bin\java -classpath 
“{DPIPE_HOME}\lib\SD.jar;{DPIPE_HOME}\lib\pidb.jar;{DPIPE_HOME}\lib\jconn2d.jar;{DPI
PE_HOME}\lib\classes12.jar;{DPIPE_HOME}\lib\Opta2000.jar;” SD {DPIPE_HOME} c change

and

{DPIPE_HOME}\jre\bin\java -classpath 
“{DPIPE_HOME}\lib\SD.jar;{DPIPE_HOME}\lib\pidb.jar;{DPIPE_HOME}\lib\jconn2d.jar;{DPI
PE_HOME}\lib\classes12.jar;{DPIPE_HOME}\lib\Opta2000.jar;” SD {DPIPE_HOME} c help
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Unix:

{DPIPE_HOME}/jre/bin/java -classpath “{DPIPE_HOME}/lib/SD.jar:{DPIPE_HOME}/lib/
pidb.jar:{DPIPE_HOME}/lib/jconn2d.jar:{DPIPE_HOME}/lib/classes12.jar:{DPIPE_HOME}/
lib/Opta2000.jar:” SD {DPIPE_HOME} c change

and

{DPIPE_HOME}/jre/bin/java -classpath “{DPIPE_HOME}/lib/SD.jar:{DPIPE_HOME}/lib/
pidb.jar:{DPIPE_HOME}/lib/jconn2d.jar:{DPIPE_HOME}/lib/classes12.jar:{DPIPE_HOME}/
lib/Opta2000.jar:” SD {DPIPE_HOME} c help

If the privileges were not right, the following error will be captured at the command prompt:

Message   : ORA-01031: insufficient privileges

SQLState  : 42000

ErrorCode : 1031

How to Create Views Manually

Follow these steps to create views manually:

1 Configure OVPI to recognize the Service Desk 4.5 database as an external database.

2 Perform any other pre-installation tasks. 

3 Run the following commands at the command prompt.

{DPIPE_HOME}/bin/perl {DPIPE_HOME}/packages/SD45_Datapipe/
SrvDsk_ChangeManagement45_DP.ap/Launch_Create.pl

{DPIPE_HOME}/bin/perl {DPIPE_HOME}/packages/SD45_Datapipe/SrvDsk_HelpDesk45_DP.ap/
Launch_Create.pl

Is Data Being Collected?

Collecting data about incidents, problems, service calls or changes items raised during the 
last three days populates the following tables on the report pack side:

• RSERVD_PROBLEMS_DATAPIPE

• RSERVD_INCIDENTS_DATAPIPE

• RSERVD_SERVICECALLS_DATAPIPE

• RSERVD_CHANGES_DATAPIPE 

If data collection took place as expected, the system can tell you how many rows of data were 
collected for each table. Follow these steps:

1 Login to OVPI.

2 Run the following queries at the sql prompt:

• select count(*) from RSERVD_INCIDENTS_DATAPIPE;

• select count(*) from RSERVD_PROBLEMS_DATAPIPE;

• select count(*) from RSERVD_SERVICECALLS_DATAPIPE;

• select count(*) from RSERVD_CHANGES_DATAPIPE;
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For each query, the system displays the number of rows collected.

Collecting Data Manually

Follow these steps to collect data manually: 

1 Stop OVPI Timer and wait for processes to terminate.

2 Open the command prompt.

3 Change to the {DPIPE_HOME}/scripts/ directory.

4 Run the following commands:

trend_proc –f SrvDsk_Hlpd_Retrieve_Data.pro

trend_proc –f SrvDsk_Chm_Retrieve_Data.pro

5 Verify that data was collected.

What to Do If No Data Is Collected

If you try to collect data manually, but the collection still does not take place, follow these 
steps:

1 Connect to Service Desk 4.5 database using user id and password. 

2 Column ta_period in views gives the time period at which incidents, problems, servicecalls 
or changes were registered in service desk or its status was modified.

Run the following queries:

select count(ta_period) from itsm_incidents_v where ta_period>sysdate-3;

select count(ta_period) from itsm_problems_v where ta_period>sysdate-3;

select count(ta_period) from itsm_servicecalls_v where ta_period>sysdate-3;

select count(ta_period) from itsm_changes_v where ta_period>sysdate-3;

3 Check if any number of rows selected for Time Period that fall within the last 3 days 
duration.

4 Check if the OVPI system has been configured properly. 

5 Check whether the following two .pro files are modified for –S option

{DPIPE_HOME}/packages/SD45_Datapipe/SrvDsk_HelpDesk45_DP.ap/
SrvDsk_Hlpd_Retrieve_Data.pro

{DPIPE_HOME}/packages/SD45_Datapipe/SrvDsk_ChangeManagement45_DP.ap/
SrvDsk_Chm_Retrieve_Data.pro

The Server name with the –S option should be exactly same as the name you added as 
external database.

6 Check {DPIPE_HOME}/log/trend.log file for information about errors that occurred 
during data collection. An excerpt from trend.log, below, contains examples of the error 
messages that were generated during data collection.
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No Data in Reports

Since most reports are built on daily, weekly, and yearly tables, your first step is to verify that 
tables contain data for the reporting period. A report needs at least 1 day, 1 week, 1 month, 
and 1 year before data can roll up to daily, weekly, monthly, and yearly tables, respectivly.

Make sure that all the entries, including Category Name, Classification Name, Organization 
Name, Actual Start Date, Actual Finish Date, and Actual Duration, were entered properly in 
Service Desk. For example, if the Service Desk user fails to indicate the category, then the 
OVPI report will report the incident category as unknown, making it impossible to locate the 
incident in a by-category report. The same is true for changes, problems, and service calls. If 
the attributes are not specified, the sorting function in OVPI will not be able to categorize the 
item.
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10 Troubleshooting Help Desk and Change 
Manager Data
The export of Help Desk and Change Manager data from Service Desk to OVPI is automatic. 
No user intervention is necessary. 

Entity Exporter and the OVPI SOAP Interface

The diagram below shows Service Desk exporting data to OVPI. 

The SD platform on the left is using Entity Exporter to export SD Entities (ServiceCall, 
Problem, Incident, Change), configured by the XML entity mapping file, to the OVPI system 
through an OVPI Simple Object Access Protocol (SOAP) interface. The SD entities are stored 
in staging tables.

Moving Change Manager and Help Desk Data to OVPI

Following is a step-by-step description of data flow.

1 Entity Exporter reads the SDEntitiesReportMapping.xml file, located here:
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C:\Program Files\HPOpenView\data\conf\report\SDEntitiesReportMapping.xml

2 Entity Exporter exports SD entities to staging tables on OVPI.

3 Entity Exporter updates the following log:

C:\Program Files\HP OpenView\data\log\sd_report_admin.log0.0.en_US 

4 Every hour, trend_timer calls a PL/SQL procedure (ServD_XXX_map_p). 

5 The PL/SQL procedure uses ee_collect to transfer entities from staging tables to:

• Data tables (RSERVD_xxx)

• Property tables (K__SERVD_xxx)

6 The PL/SQL procedure updates the following logs:

• RSDCM_PROCEDURELOG

• RSDHD_PROCEDURELOG

7 Once an hour, trend_timer calls SrvDsk_HelpDesk_Hourly.pro and 
SrvDsk_ChangeManagement_Hourly.pro; based on directives in this files, trend_sum 
calculates hourly totals and hourly averages. 

8 OVPI updates trend.log.

9 Once a day, at 2:00 a.m., OVPI summarizes data for the day based on hourly 
summarizations that took place during the previous 24 hours.

The following diagram illustrates the data flow described above.
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11 Troubleshooting Dimension and Fact Data
The SLM core exports data to OVPI. Fact data is exported to DataFeeder on OVPI, and 
dimension data is exported to DimensionManager on OVPI. The .csv files created by 
DataFeeder and DimensionManager on OVPI are collected by ee_collect and aggregated by 
trend_sum. The diagram on the next page shows the SLM core exporting data to OVPI. 

For a list of SLM dimensions and facts, see Appendix D, SLM Dimensions and Facts.

Data Flow for Dimension Data

The following procedure describes how dimension data moves from Service Desk to OVPI.

1 From the SLM core system, launch ReportingConfigTool.bat.

2 The Reporting Config Tool exports SLA, Service, and SLO information (the entire model) 
to Dimension Manager. 

3 The Reporting Config Tool logs all exported Dimensions to:

C:\Program Files\HP OpenView\data\log\ReportingConfigTool0.0.en_US

4 Dimension Manager generates CSV files and spools CSV files to the following directory:

{DPIPE_HOME}\data\ImportData\SLM\Dims\

5 Dimension Manager logs all the Dimensions received to this spool directory:

C:\Program Files\HP OpenView\data\log\DimensionManager0.0.en_US

6 OVPI (trend_timer) calls import_SLM_data.pro, which scans the spool directory.

7 import_SLM_data.pro calls ee_collect; ee_collect uploads data to:

• Staging tables (SLM_P_xxx)

• Dimension tables (SLM_K_xxx)

8 import_SLM_data.pro archives uploaded CSV files to:

{DPIPE_HOME}\data\ImportData\SLM\Archived\

9 OVPI updates the trend.log file.

10 import_SLM_data.pro calls the following script:

execute_PLSQL_update_SLM_P_tables.sql 

11 The PL/SQL update script uploads dimension data from staging tables (SLM_P_xxx) to 
property tables (SLM_K_xxx).
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12 The PL/SQL update script updates foreign keys in the SLM_K_SLA property table:

• The OID in the Paying Entity column is cross-referenced against the SLM_K_User 
table, and the corresponding dsi_key_id is updated in the PayingEntity column.

• The OID in the CRM column is cross-referenced against the SLM_K_User table, and 
the corresponding dsi_key_id is updated in the CRM column.

• The OID in the ServiceLevel column is cross-referenced against the 
SLM_K_SERVICELEVEL table, and the corresponding dsi_key_id is updated in the 
ServiceLevel column.

13 OVPI updates the SLM_R_PROCEDURE_LOG table. 

14 OVPI empties the staging tables.

The diagram on the next page illustrates the flow of dimension data from Service Desk to 
OVPI.
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Sample CSV File

ee_collect loads CSV files from the following directory:

{DPIPE_HOME}\data\ImportData\SLM\Dims\

If the CSV files that reach this directory are staying there, not disappearing within a few 
minutes, there is a problem. The problem could be that Oracle is down, or a disk is full. If the 
database is down or if a disk is full, ee_collect won’t be able to remove files from this directory. 

Sample Log Created by DimensionManager

DimensionManager is a simple program. It writes files to the spool directory. If 
DimensionManager encounters a problem, it writes an error message. See the sample log 
below. The following events will cause DimensionManager to generate an error message:

• DimensionManager cannot locate the spool directory

• DimensionManager cannot write to the spool directory

If DimensionManager cannot write to the spool directory, either the system is full or access 
rights were not properly set.
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SQL Procedure Log Updated by OVPI

The SQL Procedure log records foreign key updates only. Reviewing this log is an easy way to 
verify that the system is working correctly. Use this log to see how many rows per property 
table were updated. If no rows are being updated, the source of the problem could be Oracle.
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Using Report Builder to Identify Tables and Views

If a report contains no data, use Report Builder to verify that tables contain data and that 
foreign keys were updated correctly. In the example below, the user is opening a report from 
Report Builder and checking for data in two places, SLM_RV_SLA_EXT and its property table 
SLM_KV_SLA.

After ee_collect imports dimensions, the script execute_PLSQL_update_SLM_P_tables.sql is 
invoked. This script updates the foreign keys in the SLM_K_SLA table. It updates foreign 
keys by setting the PayingEntity column to the foreign key in the SLM_K_USER table, by 
setting the CRM column to the foreign key in SLM_K_USER table, and by setting the 
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ServiceLevel column to the foreign key in the SLM_K_SERVICELEVEL table. As a result, 
these columns, containing OIDs, are updated with table dsi_key_ids. The PLSQL update 
script records the number of rows that were updated in SLM_R_PROCEDURE_LOG. 

Moving Fact Data to OVPI

The export of fact data to OVPI is automatic. No user intervention is required. This is how it 
works:

1 SLM core creates two kinds of DataPoints:

• Configuration DataPoints

• Runtime DataPoints

2 SLM core sends DataPoints to DataFeeder on the OVPI server:

• Configuration DataPoints are sent at SLM startup (timestamp=0). 

• Runtime Datapoints are sent when a new metric value is received, when calculated 
status is changed, at SLA Evaluation Period start/end, and for CI Planned Downtime 
and Service Hours.

3 SLM core updates the following log file:

C:\Program Files\HP OpenView\data\log\slm0.0.en_US

4 The SLM core uses a reliable communications system based on store-and-forward. If the 
SLM core is unable to send data, it stores the data it cannot send in a spool directory. 
Later, when sending data is possible, the SLM core retrieves data from the directory and 
sends it. This is the path to the store and forward spool directory: 

C:\Program Files\HP OpenView\data\data\Data_Exporter\snf

5 DataFeeder updates temporary storage table, SLM_STAG_xxx.

6 DataFeeder updates staging tables. The staging tables contain current values (no history) 
for all the metrics and all the status facts managed by SLM.

Sample staging table:

7 DataFeeder spools CSV files containing current fact data to the following directory:

{DPIPE_HOME}\data\ImportData\SLM\Facts\

8 Every 5 minutes, import_SLM_facts.pro scans the spool directory; if files are located, 
import_SLM_facts.pro calls ee_collect.

9 ee_collect reads the CSV files and populates rate tables (SLM_R_xxx).
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10 Every hour, trend_sum calculates hourly statistics for:

• SLA

• Service

• CI

• SLO

• SLO Compliance

11 Once a day, trend_sum calculates daily statistics for:

• SLA

• Service

• CI

• SLO

• SLO Compliance

The diagram on the next page illustrates data flow.
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Hourly and Daily Summarizations

The following table provides a list of hourly and daily statistics calculated by trend_sum.

Log Files to Investigate

If an error occurs during an export, the Status field in the Reporting Administration 
workspace view displays Error. To find out more about the error, check the following files:

Fact In the Hour/In the Day Statistics

SLA • Total compliant time
• Total jeopardy time
• Total violated time 

Service • Total compliant time
• Total jeopardy time
• Total violated time 
• Total achieved time
• Total not achieved time
• Total not yet computed time

CI • Total achieved time 
• Total not achieved time 
• Total not yet computed time 

SLO • Total achieved time
• Total not achieved time 
• Total not yet computed time
• Min value 
• Max value
• Average value 
• Last objective value
• Total violation time

SLO Compliance • Total compliant time 
• Total jeopardy time 
• Total Violated time 
• Max value
• Min value 
• Total achieved time 
• Total not achieved time
• Total not yet computed time
• Min value 
• Max value 
• Average value 
• Last objective value 
• Last value Total violation time
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• Global Service Desk log file

<installDir>/data/log/System*.*en_US

• Dedicated Service Desk Reporting log file

<installDir>/data/log/sd_report_admin.log*.*.en_US

• OVPI log on the OVPI server:

<OVPIInstallDir>/log/trend.log

In addition, you can activate tracing and check the trace files.

C:\OVPI\data\ImportData\SLM\Facts\SLA_1131405300000_152.csv

00000000-0000-0000-0281-a2a2224175aa 20051108 00:15:004 4

00000000-0000-0000-0281-a2a2224175ab 20051108 00:15:000 0

Logging All Datapoints 

DataFeeder logs all the DataPoints it receives to the following file:

C:\Program Files\HP OpenView\data\log\DataFeeder0.0.en_US

See below for a sample log.
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Moving Time Periods to OVPI

The export of Time Periods from SLM core to OVPI is automatic. No user intervention is 
required. Following is a step-by-step description of data flow.

1 SLM core creates two kinds of DataPoints:

• Configuration DataPoints (SLA Evaluation Periods)

• Runtime DataPoints (Service Hours and Planned Down Times)

2 SLM core sends Configuration DataPoints at SLM startup (timestamp=0). 

3 SLM core sends Runtime DataPoints when a new metric value is received, when 
calculated status has changed, at SLA Evaluation Period start/end, and for CI Planned 
Downtime and Service Hours.

4 Each time DataFeeder receives a DataPoint, it updates the following staging tables: 

• SLM_STAG_EVALPERIOD

• SLM_STAG_PLANNEDDT

• SLM_STAG_SERVICEHOURS

5 Every 5 minutes, DataFeeder generates CSV files containing all received Time Periods.

6 The import_SLM_facts.pro script scans the facts spool directory and uses ee_collect to 
import Time Period data into the following staging tables:

• SLM_P_EVALPERIOD

• SLM_P_PLANNEDDT

• SLM_P_SERVICEHOURS

7 The import_SLM_facts.pro script calls SLM_Period_Update_p, a PL/SQL procedure. 
SLM_Period_Update_p adds new Time Period to three tables:

• SLA Evaluation Periods --> SLM_K_EVALPERIOD table

• Service Hours and CI Planned Downtimes --> DSI_SHIFT table

• Service Hours and CI Planned Downtimes --> DSI_SHIFT_SET table

The diagram on the next page illustrates data flow.
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Report Builder: Service Hours and CI Planned Downtime

The CI and related SLA reference can be found in CI and SLA Dimension tables:

• SLM_K_CI

• SLM_K_SLA

With that information, you can get:

• The key_id of the corresponding entry in the SLM_K_CI2SLA table

• The PlannedDT id in the same table (9999 in this example)

In DSI_SHIFT_SET, the CI Planned Downtime is identified by this name:

PDT_xxx

where xxx is the id found in:

• SLM_K_CI2SLA table, or

• shiftset_set_id (9999 below)

Knowing the shift_set_id (9999) you can find all the periods for CI planned Downtime, given 
by start/end date, in the DSI_SHIFT table.
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Sample Log File for PL/SQL Procedure

The import_SLM_facts.pro script calls SLM_Period_Update_p. SLM_Period_Update_p adds 
new Time Period to three tables:

• SLA Evaluation Periods --> SLM_K_EVALPERIOD table

• Service Hours and CI Planned Downtimes --> DSI_SHIFT table

• Service Hours and CI Planned Downtimes --> DSI_SHIFT_SET table

See below for an extract from the SLM_R_PROCEDURE_LOG table.
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Appendix A: Platform Requirements
This appendix covers the following topics:

• Supported operating systems and databases, per-component

• Metric adapter options for the Service Level Manager module

• Instructions for installing Oracle on the OVPI server

• Instructions for creating an Oracle database

Supported Operating Systems and Databases

See below for a list of supported operating systems and databases, per-component.

Metric Adapter Options for Service Desk

Service Level Manager uses HP OpenView monitoring applications to measure the 
availability and compliance status of services. Without the regular collection of data from 
these monitoring applications, you cannot monitor compliance nor can you view SLM reports. 

Component Operating System Database

SD Management Server Windows 2000 SP4
Windows 2003 SP1
HP-UX PA 11.11
HP-UX 11.23 (PA-RISC and Itanium)
Sun Solaris 9 and 10

Oracle 9.2.0.5 with patch
Oracle 9.2.0.6e
Oracle 10g Release 1+
MS SQL Server 2000 SP 3a

SD 5.1 GUI Client
SD Object Loader
SD Agent

Windows XP Professional
Windows 2000 SP4
Windows 2003 SP1
HP-UX PA 11.11
HP-UX 11.23 (PA-RISC and Itanium)
Sun Solaris 9 and 10

Oracle 9.2.0.5 with patch
Oracle 9.2.0.6
Oracle 10g Release 1+
MS SQL Server 2000 SP 3a

OVPI 5.1 Windows 2000 SP4
Windows 2003 SP1
HP-UX PA 11.11
HP-UX 11.23 (PA-RISC and Itanium)
Sun Solaris 9 and 10

Oracle 9.2.0.5 with patch
Oracle 9.2.0.6
 191



Metric adapters do the work of collecting data. The following table provides a list of metric 
adapters and indicates which OpenView monitoring application the adapter works with. You 
can install metric adapters on the Service Desk Management Server or you can install metric 
adapters on the system that is running the monitoring application.

For more information about metric adapters, see HP OpenView Service Desk Open Metric 
AdapterDeveloper Guide. Metric adapter installation and configuration is covered in the HP 
OpenView Service Desk Installation Guide. For information about generic metric adapter 
configuration settings, see the HP OpenView Service Desk Service Level Manager Guide.

Installing Oracle 9.2 on OVPI

1 Click Next in the “Welcome” screen.

2 Accept defaults (OraHome92). Click Next.

3 Accept default. Click Next.

4 Select Custom. Click Next.

5 Deselect the following options:

a Enterprise Edition Options: 

— Oracle Advanced Security

Metric Adapter Monitoring Application Function

OVIS MA Internet Services Measure availability and compliance 
by collecting values from an OVIS 
database.

OVPM MA Performance Manager Measure availability and compliacne 
by collecting values available to an 
OVPM server.

OVSD MA Service Desk Automatically installed and 
configured when you install the 
Service Desk management server. 
Allows you to measure availability 
and compliance based on analyzed 
data criteria logged by a Service 
Desk server.

OVSN MA Operations Service Navigator Collects and publishes metric data 
values based on service status 
change events. Measures the 
availability of configuration items as 
well as service compliance. Discovery 
identifies all Service Navigator 
services currently being monitored. 
The initial discovery process delivers 
service status to the application 
server. Thereafter, the metric 
adapter publishes each status 
change event.
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— Oracle Spatial

— Oracle Data Mining

b Oracle Enterprise Manager products: 

— Enterprise Manager Web site

— Oracle Management Server

— Oracle Change Management Pack

— Oracle Diagnostics Pack

— Oracle Tuning Pack

c Oracle9i Development Kit

d Oracle9i Windows Documentation

e Oracle HTTP Server

f Oracle Transparent Gateways

6 Click Next.

7 Accept the defaults. Click Next.

8 Select No (do NOT create a database now). Click Next.

9 Click Install. 

Creating a New Database

Follow these steps to create a new database:

1 Select Start > Programs > Oracle - OraHome92 > Configuration and Migration Tools > Database 
Configuration Assistant.

2 Choose the following options and click Next after choosing each option:

• Create a database

• New database

• Database name: OVPI

• Accept defaults

• Accept default

• Memory Tab: select Typical, accept default memory percentage (70%) 

• Character sets Tab: select Use Unicode (AL32UTF8) 

• Accept defaults 

3 Accept defaults – Click Finish
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Appendix B: Scheduling Reports
To generate a report, create a schedule that includes information about how and when the 
Web Access Server should run the schedule. Then add the events (reports) you want to 
generate to the schedule. You can add one or more reports to any schedule. 

The higher-level tasks are as follows:

• Task 1: Create a new schedule

• Task 2: Add reports to the schedule

• Task 3: Specify the formats for reports

• Task 4: Schedule when the report runs

• Task 5: Select the recipients

• Task 6: Specify parameters

• Task 7: If necessary, change the schedule

Task 1: Create a new schedule. 

1 Use your web browser to access the Web Access Server.

2 Log in to the Web Access Server.

3 Click Schedule in the links bar. The Schedule page opens.

4 Expand the Schedules folder and click New Schedule. The Create a New Schedule page 
opens.

5 In the Schedule Title box, enter a name for the schedule you want to create.

6 Select Add to Generator Timer.

7 Select the hour, the number of minutes past the hour, and a.m. or p.m.

8 Click Create. The schedule_name page opens.

Task 2: Add reports to the schedule.

1 Click Add Event. The New Schedule Event page opens.

2 Click Browse to display the Report Browser window.

3 Expand the folders to locate the report you want to schedule.

4 Click the report when you locate it. The Report Browser window closes, and OVPI updates 
the New Schedule Event page. 

Task 3: Specify the formats for reports

1 Click Next. The Formats page opens. 

2 Click Activate. 

3 Indicate a drilldown depth. The default value is 5.
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4 Select the report formats you want to generate. Your options are:

• .html – You can view HTML reports on your local system using the Web Access 
Server.

• .srep – A dataset report is a repository of queried data. Once it is generated, it does 
not access the database, so this is a fast and efficient way to view data.

• .csv (simple) – A comma separated value file in which all elements are displayed in 
CSV format.

• .csv (hybrid) – A comma separated value file in which tables are displayed in CSV 
format and charts and graphs are displayed as images.

• .pdf – A Portable Document Format (PDF) file lets you view the report using Adobe 
Acrobat Reader.

5 Type the number of days that you want to keep the report. The default is to keep the 
report indefinitely. You can keep a report for any number of days.

6 Click Next. The Triggers page opens.

Task 4: Schedule when the report runs.

1 Select one of these options:

• To generate the report on a specific day of the month, click the appropriate box for the 
day or days of the month.

• To generate the report on a specific day of the week, click the box for the day or days of 
the week.

• To generate the report quarterly, click Generate Report Quarterly.

2 Click Next or Finish to continue. 

If you selected PDF for the format of the generated report, then the Email Generated PDF 
page opens. If you do not want to email the PDF, click Next in the Email Generated PDF 
page.

Task 5: Select the recipients who will receive the generated PDF report.

1 If it is not already open, open the Email Generated PDF page. 

2 Select a user in the Available Users/Groups box, and click Add. Repeat for each user.

3 In the Subject box, type the subject text for the email message.

4 In the Message box, type the message you want to send to the recipients.

5 Click Next. The Parameters page opens. 

Task 6: Specify the parameters for the report.

1 Type the values for any parameters listed.

2 Click Finish to schedule the reports for generation.

Task 7: If necessary, change the schedule:

1 Open the Schedule Title page.

2 Click the title of an event in the Schedule Title page. The Formats page opens.
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3 Click the View Details button to display detailed information about the event. 

4 Do one of the following:

• Click Finish to schedule the report for generation.

• Use cron or trendtimer to schedule report generation.
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Appendix C: View Options
You have multiple view options for any table or graph. While the default view is usually 
adequate, you can easily change to a different view. If you are using Report Viewer, right-click 
the object to open a list of view options. If you are using the Web Access Server, follow these 
steps to change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click the Edit icon next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option.

Style Options

Select Style to display a list of seven view options for graphs.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for multiple days, you will see multiple pie graphs, one per day.
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Display Data Table

This option changes a graph into a spreadsheet. 

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Appendix D: SLM Dimensions and Facts
The following table provides a list of dimensions and facts for SLM. 

Dimensions Fact Data

SLA Name
Description
Evaluation Period
Start/End date
Users
Service Level

Compliance status
Predictive Compliance status

Service Name
Description
SLA
Users

Compliance status
Predictive Compliance status
Availability status (Objective Status 
of the Service Infrastructure Metric)

CI Name
Description
Category
SLA

Instant Availability status of the CI 
per SLA

SLO/Metric Name
Description
Objective Condition
Objective Value Type
SLA
CI
Metric

Instant Compliance status
Metric Value
Objective Value

Compliance SLO/Metric Name
Description
Objective Condition
Objective Value Type
SLA
Service
Metric
Compliance Thresholds 
(%)

Instant Compliance status
Metric Value
Objective Value
Compliance Status and %
Predictive Compliance Status and %
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Time Periods SLA Evaluation Periods
Service Hours
CI Planned Downtimes

SLA evaluation periods are based on 
a dedicated dimension table; values 
for Service Hours and CI Planned 
Downtimes are generated by an 
OVPI shift set feature.

Dimensions Fact Data
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Appendix E: Configuring SD for Attachments
Service Desk can include attachments with Service Desk items. Attachments are handled by 
an FTP server. This can be any third-party server, so long as Service Desk is configured to 
communicate with it. Before configuring Service Desk for attachments, create a user account 
and folder for Service Desk on the FTP server.

Follow these setps to configure Service Desk for the Attachment server:

1 Log onto a Service Desk client as an Administrator.

2 From the OV Configuration workspace, choose System Settings and then choose 
Attachment Settings. The Attachments Setting dialog box opens. 

3 Enter the Hostname of the attachments server and the User name (account) and 
Password that Service Desk will use to connect to the server.

The Target folder is the folder on the attachments server where the attachments are stored. 
Create the folder before you configure these settings.

Click the Use passive FTP box on if you do not want to use active FTP. With Passive FTP you 
can set up firewalls between the Service Desk Server and file server that opens specific ports 
for transfer and control.

Test the connection by clicking Test connection. Test connection creates a test directory on the 
file server, named test-<random number>. This directory is used for troubleshooting.

Click the Save attachments in background box on to continue working while you save an 
attachment. This can be useful if your network connection is slow, resulting in delays during 
the save process. Use this feature for slow connections only. The system assumes the 
attachment will be saved successfully—no notification is provided in the case of unsuccessful 
saves. If the save action fails, the attachment is lost and this remains unnoticed until you 
attempt to retrieve the file.

To protect your system from virus attacks, install a virus scanner on your FTP server and 
schedule it to regularly check the attachments.
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Glossary
BS15000 Standard

A standard based on the ITIL framework, issued by the British Standards Institution, that 
provides implementation guidelines for IT service management. 

change

When a change is needed, details about the change are entered in the Service Desk change 
form. The change form allows the user to select relevant approvers, indicate a deadline for 
responses, create a series of work orders, and assign each work order to a work group.

COBIT

Control Objectives for Information and Related Technology is an open standard published by 
the Information Technology Governance Institute (ITGI).

JSR-168

Java Specification Request #168 is a Java portlet definition that provides standards for API’s 
to allow information transfer between applications, specifically the areas of aggregation, 
personalization, presentation, and security. See: http://www.jcp.org/en/jsr/detail?id=168 

ICMB

ITIL Certification Management Board.

incident

Similar to a service call, with a different source. The source of a service call is a customer. The 
source of an incident is a network management tool, a system management tool, or possibly a 
technician. Any notification that is generated automatically, say for example, in response to a 
login error, or in response to a threshold breach, or in response to a printer not working, is an 
incident.  A Service Desk user will use an incident form to describe the incident.

ITIL

Information Technology Infrastructure Library (ITIL) is a series of book that specify best 
practices for managing IT infrastructure processes and changes. The series was revised in 
2000 and will be revised again in 2006. The titles in the series are:

• Software Asset Management

• Service Support

• Service Delivery

• Planning to Implement Service Management

• ICT Infrastructure Management

• Application Management
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• Security Management

• The Business Perspective

metric adapter

A software module that you install and configure to collect metric data values from 
monitoring software applications.

metrics 

The results of measurements that provide the basis for SLM reports on compliance and 
availability, and for compliance status monitoring in the OpenView console. Metric data 
values are collected from external monitoring applications (for example HP OV Performance 
Manager) or from analyzed data collected from Service Desk.

problem

A service call, or an incident, that cannot be solved until it is investigated further. The person 
responsible for investigating a problem will open a problem form.  The status of the problem is 
New. The problem form describes the problem, identifies the CI involved, and provides 
information about service calls, work orders, and approvals related to the problem. As soon as 
the problem is investigated and a remedy is identified, the person investigating the problem 
changes the status to Route Cause Identified and and adds a change process to the problem 
form.

service contract

Reduces administrative overheads by enabling legal entities and common data shared by 
multiple service level agreements to be specified once instead of multiple times. The 
agreements and services specify the deliverables and the associated service provider and 
receiver parties. Service level managers may find service contracts useful when setting up 
multiple services and agreements, especially for organizations with many sub-divisions, each 
with their own service level requirements.

service definition

A conceptual description of a service that provides a blueprint for structuring a service. The 
definition allows you to show how services, service levels (the degree of support provided to 
the customer), Service Level Agreements, CI definitions, and other service definitions relate 
to each other. The service definition allows you to create multiple service instances and 
associated service levels.

service hierarchy

Specifies the relationships between the services and configuration items that a particular 
service depends on.

service level agreement

Specifies which services are to be delivered, the associated service quality, for example, 
performance aspects, and the associated quantity of each service, that is, the level of 
availability. The service level agreement forms the core of HP OpenView Service Level 
Manager.
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Index
A
applying constraints

service, 13
service manager, 13

attachments
FTP server, 209
passive FTP, 209
setting up in Service Desk, 209

C
change max rows option, 201

configuration item (hourly and daily statistics), 185

customer-specific reports, 13

D
data aging, 38

database views
ITSM_CHANGES_V, 19
ITSM_INCIDENTS_V, 19
ITSM_PROBLEMS_V, 19
ITSM_SERVICECALLS_V, 19

Display Data Table, 201

displayed data option, 201

E
editing parameters, 13

ee_collect, 16, 172, 175, 179, 181, 182, 187

error messages in trend.log, 165, 168

Evaluation Period Aging (form), 38

execute_PLSQL_update_SLM_P_tables.sql, 175

exporting data to OVPI
Change Manager, 35
dimension data, 37
fact data, 37
Help Desk, 34
SLM core, 37

G
grid options, 201

group filters, 13

I
import_SLM_data.pro, 175

incremental export
Change Manager data, 36
HelpDesk data, 35

installing Oracle 9.2
creating a new database, 193
options for OVPI, 192

L
legend options, 201

M
metric adapters

ovisma, 192
ovpmma, 192
ovsdma, 192
ovsnma, 192

O
OvObsReportAdmin script, 35, 36

OVPI Timer
starting, 23, 30

P
Product Manuals Search (web page), 14
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R
reporting

OVPI reports (CM)
average duration of changes, 109
changes by category, 111
changes by classification, 113
changes by closure code, 123
changes closed before deadline by category, 

115
configuration and logging, 108
incoming changes (history), 125
incoming changes (recent), 127

OVPI reports (HD)
average duration of service calls, 43
configuration and logging, 42
incidents by closure code, 79
incidents closed before deadline by category, 

71
incoming service calls (history), 59
incoming service calls (recent), 61
service calls by category, 45
service calls by classification, 47
service calls by closure code, 57
service calls closed before deadline by 

category, 49
service calls closed by deadline, 51
service calls closed on first call, 53
service calls details, 55
summary, 41, 63, 85

Reporting Config Tool, 175

ReportingConfigTool.bat, 175

reporting daemons
ovsdreport, 34
ovsdslm, 34

report pack tables
RSERVD_CHANGES_DATAPIPE, 167
RSERVD_INCIDENTS_DATAPIPE, 167
RSERVD_PROBLEMS_DATAPIPE, 167
RSERVD_SERVICECALLS_DATAPIPE, 167

report parameters, 13

S
scheduling reports

add reports to a schedule, 195
create a new schedule, 195
schedule when the report runs, 196
selecting the recipients, 196
specifiying parameters, 196
specifying the formats, 195

Serverfile.txt, 19

SLA (hourly and daily statistics), 185

SLM_R_PROCEDURE_LOG table, 177

SLM fact data (hourly and daily statistics), 185

SLM Logging Level (form), 39

SLM reports
administration reports, 37, 38

SLO (hourly and daily statistics), 185

SLO compliance (hourly and daily statistics), 185

SrvDsk_Chm_Retrieve_Data.pro, 168

SrvDsk_Hlpd_Retrieve_Data.pro, 21, 168

style options for graphs, 201

supported platforms, 15

T
Time Shift Data Aging (form), 38

trend_export, 16, 19

trend_sum, 172, 175, 183, 185

troubleshooting
database views, 166
report pack tables, 167
Serverfile.txt, 165, 166
trend.log, 165
username privileges, 166

U
Use Absolute Time, 199

V
view in new frame, 200

views
ITSM_CHANGES_V, 166
ITSM_INCIDENTS_V, 166
ITSM_PROBLEMS_V, 166
ITSM_SERVICECALLS_V, 166
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